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Chapter 185

Delivery 
Effects Processing
This chapter discusses how different video effects will be handled 
when you use the controls of the Deliver page.
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Delivery Effects Processing
For your final output, how effects are rendered depends on whether you’re rendering in Single Clip or 
Individual Clips mode. 

When Rendering a Single Clip or 
When Outputting to Tape
Whether you’re rendering a QuickTime or MXF master of your project as a single clip, rendering a DPX 
image sequence for film output, or outputting directly to tape, all supported compositing, speed, and 
transform effects are rendered by DaVinci Resolve and “baked” into the output media. Unsupported 
effects are completely ignored, cannot be seen, and have no effect on media that’s rendered 
and output.

When Rendering Individual Source Clips  
for Round-Trip Workflows
In workflows where you’re rendering individual media files to send a project back to an NLE 
or finishing application for final finishing (adding titles and other effects before final delivery), 
DaVinci Resolve handles different types of effects in different ways.

Unsupported effects do not appear in DaVinci Resolve. However, this effects data is internally 
preserved, and when you export an XML or AAF file to send back to your NLE of choice, these 
effects reappear, applied to the color corrected media that you rendered out of DaVinci Resolve and 
sent back.

Effects that DaVinci Resolve does support such as composite modes, opacity settings, speed effects, 
and transitions are handled differently. Even though these effects are visible in DaVinci Resolve while 
you work, they’re not “baked” into the final media that you render in preparation for sending back to 
your NLE or finishing application. Instead, the portion of each media clip that’s used in your project is 
rendered as an individual file, and the XML file that you export from DaVinci Resolve contains all of the 
effects information necessary to reassemble the rendered media into a timeline that uses Final Cut 
Pro effects applied to DaVinci Resolve-graded media.

EDL FCP 7 FCP X
Premiere  
Pro

Media  
Composer*

Color Corrections N/A N/A Rendered N/A N/A

Composite Modes N/A Sent Back Sent Back Sent Back Rendered

Alpha Channels N/A
Optionally 
Rendered

Optionally 
Rendered

Optionally 
Rendered

Optionally 
Rendered

Transitions Sent Back Sent Back Sent Back Sent Back Sent Back

Opacity Settings N/A Sent Back Sent Back Sent Back Sent Back

Position, Scale, Rotation N/A Conditional Conditional Conditional Conditional

Linear Speed Effects Sent Back Sent Back Sent Back Sent Back Sent Back
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EDL FCP 7 FCP X
Premiere  
Pro

Media  
Composer*

Variable Speed Effects N/A Sent Back Sent Back Sent Back Sent Back

Long Duration Still Images N/A N/A N/A N/A N/A

Freeze Frames N/A N/A N/A N/A Rendered

*  These effects are only sent back in AAF round trips when you’re updating 
an existing AAF file, rather than generating a new AAF file.

The chart shows which effects are rendered by DaVinci Resolve, and which 
effects are passed back in different round trip workflows.

After you’ve reimported your project back into your NLE or finishing application, you’re free to 
readjust these effects while completing your program, without the need to re-render individual clips 
in DaVinci Resolve.

IMPORTANT: One exception to the preservation of media and effects in round-trip 
workflows is that nested sequences from Final Cut Pro 7 and Media Composer are not 
compatible with DaVinci Resolve; XML and AAF files containing nested sequences cannot 
be imported. On the other hand, Final Cut Pro X projects containing compound clips can 
be imported.

More About Rendering Speed Effects
If you’re rendering a project with speed effects, you should be aware that DaVInci Resolve can 
optionally render speed effects using Optical Flow processing, resulting in high-quality slow motion 
and fast motion effects delivered straight out of DaVinci Resolve. If you’re satisfied with Optical Flow 
processing in DaVinci Resolve, there may be no need for you to do a round-trip export if the main 
reason you were doing so was to send the processing of slow motion clips to another application 
for rendering, and rendering the Timeline in Single clip mode will “bake” the speed effects in using 
whatever settings you’ve selected for the project, or for each clip if you’ve selected individual Retime 
Process settings for different clips.

However, if you want to send unrendered speed effects to another application, rendering your project 
in Individual source clips mode guarantees that the full range of each original clip of media will be 
rendered, with the speed effect itself exported within the XML, AAF, or EDL file that’s exported.

NOTE: DaVinci Resolve adds three frame handles to clips with speed changes applied 
to them, and to rendered clips that don’t match the project’s frame rate. This is done to 
facilitate reconform in NLEs that require handles beyond the actual length of each of 
these clips.
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Determining the Rendered Output 
Resolution of Clips in Mixed Timelines
Ordinarily, rendering individual source clips results in each clip being rendered at either the 
project resolution or the Resolution drop-down in the Render Settings (which overrides the project 
resolution), with clips that don’t match the project resolution being resized or not according to the 
settings you’ve chosen in the Image Scaling panel of the Project Settings. 

However, if you’re rendering dailies for projects containing clips with mixed resolutions, you can 
choose to render each clip at its original resolution by turning on the “Render at source resolution” 
checkbox in the Video group of controls.

Rendering Edit and Input Sizing Adjustments
Whether or not sizing is rendered into your final media depends on the “Disable sizing and blanking” 
checkbox in the Advanced Settings options of the Render Settings panel. You can disable sizing 
and blanking either when rendering the current Timeline as a single clip, or when rendering 
individual clips.

 — If “Disable sizing and blanking output” is turned off: Output Blanking, Cut and Edit page 
sizing adjustments, Color page Input and Output Sizing adjustments, and Image Stabilization are 
rendered into the final rendered media using the optical-quality sizing algorithms available to 
DaVinci Resolve. This is best if your sizing adjustments are approved and final, and you want to 
“bake” sizing adjustments into the final media you’re delivering. 

 — If “Disable sizing and blanking output” is turned on: Output Blanking, Cut and Edit page 
sizing adjustments, Color page Input and Output Sizing adjustments, and Image Stabilization 
are not rendered, and each clip will be rendered either at the source resolution if “Render at 
source resolution” is enabled in individual clips mode, or to the currently specified resolution of 
the Timeline or project. However, the sizing adjustments you’ve made will be exported as part 
of the XML or AAF file that you’re exporting. This is best for workflows where the editor wants to 
continue adjusting sizing after you’ve handed off the graded project relative to the original size of 
the clips.

Keep in mind that if you want to render Input Sizing adjustments into the media you’re outputting, the 
“Force sizing to highest quality” checkbox guarantees that DaVinci Resolve will use the highest-quality 
sizing setting, even if you’ve temporarily chosen a faster-processing option for a slower computer.

NOTE: “Disable sizing and blanking output” does not disable any transform operations that 
happen within the Fusion page, nor does it disable transforms happening as a result of an 
OpenFX or ResolveFX plugin applied to one or more clips in the Cut, Edit, or Color pages. 
All of these effects will continue to be rendered into the final output.

Rendering Mixed Frame Rate Timelines
Mixed frame rates are supported by DaVinci Resolve when any option other then none is selected 
in the “Mixed Frame Rate format” drop-down menu, either in the Conform Options section of 
the General Options panel of the Project Settings, or in the Import AAF or XML dialog. When you 
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choose the appropriate option that corresponds to the application you’re exchanging projects with 
(or DaVinci Resolve if you’re working entirely within DaVinci Resolve), then DaVinci Resolve conforms 
and processes all clips in the Timeline to play at whichever frame rate is selected in the “Timeline 
frame rate” drop-down menu. For example, 23.98, 29.97, 30, 50, 59.94, and 60 fps clips will all play at 
24 fps if that’s what “Timeline frame rate” is set to in the Master Settings panel of the Project Settings.

How clips in mixed frame rate timelines are rendered out depends on whether the Render Settings 
are set to render Individual source clips or a Single clip. 

 — Individual source clips: All clips are rendered individually at their original frame rate. 

 — Single clip: All clips are converted to the “Timecode calculated at” frame rate and rendered as a 
single media file. Clips are converted using whatever method is selected in the Retime process 
drop-down of the Master Settings panel of the Project Settings, or in the individual Retime 
process setting found in the Video inspector of each clip that overrides the project-wide setting. 
You can choose Optical Flow processing for the highest quality conversion that’s available in 
DaVinci Resolve.

Export Alpha Channels in Individual Clips Mode
This option only appears if you’re rendering to a media format that supports alpha channels. If your 
media contains an Alpha Channel, you have the option to turn on the Export Alpha checkbox in the 
Video panel of the render settings whenever you render individual source clips. When you do so, 
DaVinci Resolve renders clips with alpha channels in either of two cases:

 — Whenever there is an alpha channel embedded in the source media for that clip, the embedded 
alpha channel will be copied to the rendered version of that clip.

 — Whenever a clip’s grade has a key connected to an alpha output, the alpha output will be rendered 
as an alpha channel for that clip.

In either case, you may only render alpha channels out when you render individual source clips to an 
RGBA format such as TIFF, OpenEXR, ProRes 4444, ProRes 4444 XQ, or DNxHR 444.

Export Alpha Channels in Single Clip Mode
DaVinci Resolve allows rendering alpha channels in Single Clip mode if the selected codec supports 
an alpha channel (i.e., ProRes 4444, DNxHR 444, etc.). This lets you apply a single alpha channel to an 
entire timeline for export, rather than just at the individual clip level.

To Render an Alpha Channel in Single Clip Mode:

1 Select “Single Clip” mode in the Render Settings.

2 Select a codec that supports an alpha channel in the Video tab’s Codec and Type selection boxes.

3 Select the checkbox “Export Alpha” that appears under the Frame rate selector.

4 If supported by the codec, you can chose the Alpha Mode type. Premultiplied is the default.

If the codec you have selected does not support an alpha channel, the “Export Alpha” box will not 
appear as an option.
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Chapter 186

Using the 
Deliver Page
Once you’ve finished grading your project, you need to either 
render it, or output it to tape to deliver it to your client. This is 
where the Quick Export window and Deliver page comes in. 

This chapter describes how to use Quick Export, how to use the overall interface of the Deliver 
page, and provides some general information about how effects are output from DaVinci Resolve in 
different situations.

Contents
Using Quick Export  3976

The Deliver Page  3977

The Interface Toolbar  3977

Rendering Files vs. Outputting to Tape  3978

The Render Settings  3978

The Deliver Page Timeline  3979
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Disabling Viewer Updates While Rendering  3981

The Render Queue  3981
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Using Quick Export
Not every situation requires a complicated delivery setup. When you just need to quickly export a 
project, and the full power of the Deliver page is unneeded, you can choose File > Quick Export to 
use one of a variety of export presets to export your program from any page of DaVinci Resolve. You 
can even use Quick Export to export and upload your program to one of the supported video sharing 
services, including YouTube, Vimeo, and Frame.io. You can also add your own presets to the Quick 
Export window.

To use Quick Export:

1 (Optional) In the Cut, Edit, Fusion, or Color page, set In and Out points in the Timeline to choose a 
range of the current program to export. If no timeline In or Out points have been set, the entire 
timeline will be exported.

2 Choose File > Quick Export.

3 Select a preset to use from the top row of icons in the Quick Export dialog, and click Export.

4 Choose a directory location and enter a file name using the export dialog, then click Save. 
A progress bar dialog appears to let you know how long the export will take.

The Quick Export dialog
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The Deliver Page
The Deliver page is divided into five areas of functionality, each of which lets you set up a different 
part of a render or output to tape.

Deliver page

The Interface Toolbar
At the very top of the Deliver page is a toolbar with buttons that let you show and hide different parts 
of the user interface. These buttons are as follows, from left to right:

The Interface toolbar

Delivery full/half height button: Lets you set the Render Settings panel to take up the 
full height of your display, if you need more area for browsing the various render settings, 
at the expense of a narrower Timeline.

Render Settings: This panel lists all of the render settings that are available for 
configuring rendering jobs in DaVinci Resolve. By default, you’re presented with a short 
list, but more options are available by clicking “Advanced Settings.”

Tape: Puts the Deliver page into Tape Output mode.

Clips: Hides or shows the Thumbnail timeline above the Deliver page timeline
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 — Render Queue: A list of all jobs that you’ve set up to render in the current project. 
Previously rendered jobs remain in the queue, for your reference or for you to reuse 
to re-render those jobs, unless you manually delete them from the queue.

 — Render Queue full/half height button: Lets you set the Render Queue to take up 
the full height of your display, if you need more area for listing render jobs at the 
expense of a narrower Timeline.

Rendering Files vs. 
Outputting to Tape
Because the Deliver page does double duty, you control whether you’re rendering files or outputting 
to tape using the Tape button in the Interface toolbar. Doing so replaces the controls in the Viewer 
with tape controls.

Render or Edit to Tape modes

The Render Settings
The Render Settings contains the customizable settings that determine how media is rendered out of 
DaVinci Resolve. If you’re using the Tape option, these settings are disabled.

Render Settings
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The Render Settings are divided into four general sections:

 — Render Presets: At the very top, a scrollable row of icons lets you choose one of a series of 
presets to quickly set up the type of render you want. The Custom option exposes all render 
settings so you can set up a render manually.

 — Render Location: A Browse button opens a dialog that lets you choose a volume and directory 
to render to.

 — Render: Two options let you either render the entire selected area of the Timeline as a single clip 
suitable for reviewing or mastering, or as a series of individual clips more suited to round-trip 
workflows. The option you choose here changes which render settings are available below.

 — Video, Audio, and File Render Settings Panels: All other render settings are divided among 
three panels. Checkboxes at the top of the Video and Audio panels let you selectively disable 
video export (if you want to export the audio only) or disable audio export (if you want to 
export video only).

For more information on all of these settings, see Chapter 187, “Rendering Media.”

The Deliver Page Timeline
You’ll use the Timeline in the Deliver page to define the range of clips you want to render or output 
to tape, and to choose which versions for each clip you want to output. The Deliver page Timeline 
consists of a Thumbnail timeline at top (that can be shown or hidden via the Clips button) that makes 
it easy to select individual clips or ranges of clips that you need to render, and a more ordinary 
timeline below that you can use to set In and Out points for rendering arbitrary regions of your 
program. A Timeline toolbar lets you choose the render range of the Timeline, and has controls for 
customizing the look of the Timeline, and for zooming in and out.

The Deliver page’s Timeline and Thumbnail timeline

TIP: Press Shift-Z to fit the entire program into the available width of the Timeline.
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Filtering the Thumbnail Timeline
The Deliver page Thumbnail timeline also has the Timeline Filter drop-down, available to the right of 
the Clips button in the Interface toolbar. 

The Deliver page’s Thumbnail timeline matches the Color page

Using this drop-down to filter the contents of the Timeline lets you restrict the range of media you 
want to output in different ways. For example, if you’ve already rendered a timeline, but you’ve 
since made some changes, you can use one of the “Modified Clips” options to display only the clips 
that have changed within a particular timeframe. Another commonly used option is to choose 
“Unrendered Clips” to isolate all clips that have not yet been rendered in workflows where you’re only 
rendering a part of the Timeline at a time.

When you filter the Thumbnail timeline, you can only set up jobs to render in Individual Clips mode. You 
can tell if Thumbnail filtering is enabled by an orange underline under the Clips button in the UI toolbar.

An orange line under the Clips button 
shows that filtering is enabled

The Viewer
When rendering file-based media, the Viewer shows you exactly how the media being output will look 
using the current settings, and the transport controls move the playhead throughout the current 
Timeline. Audio playback can be turned on or off by clicking on the speaker icon, or adjust the level by 
right-clicking on the speaker icon and dragging the slider.

Deliver page Viewer
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When outputting to tape, the Viewer shows you the tape output so you can set up insert or assembly 
edit points, and the transport controls move the tape in the deck if device control is enabled. You can 
also put the Viewer into Cinema Viewer mode by choosing Workspace > Viewer Mode > Cinema Viewer 
(P), so that it fills the entire screen. This command toggles Cinema Viewer mode on and off.

Disabling Viewer Updates While Rendering
An Updates During Renders submenu in the Render page Viewer option menu lets you choose to 
disable, minimize, or enable Viewer updates while a program is being rendered. Disabled or minimized 
Viewer updates will speed rendering, especially on slower workstations.

The Render Queue
The Render Queue is a list of all the jobs you’ve queued up for delivery. Each job can have an 
individualized range of clips and render settings, which you can use to render multiple sections or 
clips of a timeline, the same timeline output to multiple formats, or multiple timelines.

The Render Queue displays all jobs

The Render Queue also has the option to show either just the jobs within the current project, or jobs 
queued up and saved within all projects in the currently open SQL network project library (for the 
current user) or local project library (at the currently selected disk location). This can be exceptionally 
useful in situations where you’ve broken a program into multiple reels, with each reel being a 
different project. This can be turned on and off via the “Show All Projects” option of the Render Queue 
Option menu.
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Jobs in the Render Queue can be edited (by clicking the pencil button), they can be assigned to remote 
rendering workstations, and they can be deleted. Jobs that have already been rendered can be kept in 
the Render Queue and re-rendered at a later time.

TIP: There is an option to show the Render Settings of each item in the Render Queue, 
by selecting “Show Job Details” in the Render Queue Option menu. This provides specific 
details of each job’s dimensions, frame rate, codec etc. This is a great help in managing a 
complex render queue at a glance.
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Chapter 187

Rendering Media
This section describes the options that are available 
for file-based delivery. 

The workflow is simple; you define the format and other settings that dictate how the media is to be 
rendered, define a range of clips in the currently selected session, and then add a job containing these 
settings to the Render Queue. 

You can queue up as many different render jobs as you like, each with different formats, output 
options, and ranges of clips, depending on what you’re trying to accomplish. When you’re ready to 
render, simply click the Start Render button.

Contents
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Using Presets for Fast Rendering
The very top of the Render Settings list has a set of presets for many of the most common rendering 
workflows you’ll need to accomplish. If you want to create your very own settings, then choose 
custom. Each preset automatically sets up what you need and locks you out of settings that are not 
necessary for rendering that type of media.

Render presets selection

Custom
When custom is selected, nothing is automatically set, and all conventional media rendering 
options are available, except for those that are specifically associated with particular presets. You 
must manually choose the settings and options you need. All Render settings are saved on a per-
project basis.

YouTube, Vimeo, Twitter, Tik Tok, 
and Dropbox Presets
These presets let you render media specifically for video sharing services, with the option to upload 
the rendered files automatically.

YouTube 720p/1080p/1440p/2160p
A drop-down menu lets you choose four different resolutions to render to and selects the appropriate 
settings for exporting your program as a file suitable for uploading to YouTube and many other video 
file sharing services. The preset renders a single clip at the timeline’s frame rate and sets the following 
parameters:

 — Format: MP4

 — Video Codec: H.264

 — Encoding Profile: High

 — Audio: Bus 1

 — Audio Codec: AAC

 — Data burn-in: Same as Project

 — Upload directly to YouTube: When this box is checked, the resulting render will automatically 
upload to your YouTube account, and the following parameters will become available. If you have 
multiple YouTube Channels on your account, you can select which channel to upload to.

 — Title: Enter the title of your video.

 — Description: Enter a description of your video.
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 — Chapters from Markers: Checking this box embeds chapter points in the YouTube video 
corresponding to the the selected marker color and the marker’s position on the Timeline.

 — Upload Thumbnail: Checking this box will open a file browser, allowing you to select a still 
image that will become the thumbnail image for your video on YouTube.

 — Visibility: You can change how your video will be accessible on YouTube.

 — Category: You can select your video’s YouTube category.

Vimeo 720p/1080p/2160p
A drop-down menu lets you choose three different resolutions to render to and selects the 
appropriate settings for exporting your program as a file suitable for uploading to Vimeo and many 
other video file sharing services. The preset renders a single clip at the timeline’s frame rate and sets 
the following parameters:

 — Format: MP4

 — Video Codec: H.264

 — Encoding Profile: Auto

 — Audio: Bus 1

 — Audio Codec: AAC

 — Data burn-in: Same as Project

 — Upload directly to Vimeo: When this box is checked, the resulting render will automatically 
upload to your Vimeo account, and the following parameters will become available.

 — Title: Enter the title of your video.

 — Description: Enter a description of your video.

 — Visible To: You can change how your video will be accessible on Vimeo, 
including password protection.

Twitter 720p/1080p
A drop-down menu lets you choose three different resolutions to render to and selects the 
appropriate settings for exporting your program as a file suitable for uploading to Twitter and many 
other video file sharing services. The preset renders a single clip at the timeline’s frame rate and sets 
the following parameters:

 — Format: MP4

 — Video Codec: H.264

 — Encoding Profile: Auto

 — Audio: Bus 1

 — Audio Codec: AAC

 — Data burn-in: Same as Project

 — Upload directly to Twitter: When this box is checked, the resulting render will automatically 
upload to your Twitter feed, and the following parameter will become available.

 — Description: Enter text to be added to your video.
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TikTok Deliver Page Preset
A drop-down menu lets you choose two different resolutions to render to and selects the appropriate 
settings for exporting your program as a file suitable for uploading to TikTok and many other video file 
sharing services. The preset renders a single clip and sets the following parameters:

 — Resolution: 1920x1080 HD

 — Use Vertical Resolution: Unchecked. Check this box if you want to deliver your video in portrait 
mode for proper display on phones. This should be on for TikTok.

 — Frame rate: The chosen frame rate of your timeline. You can also override this and set another 
frame rate manually.

 — Format: MP4

 — Video Codec: H.264

 — Encoding Profile: Auto

 — Audio: Bus 1

 — Audio Codec: AAC

 — Data burn-in: Same as Project

 — Upload directly to TikTok: When this box is checked, the resulting render will automatically 
upload to your TikTok account, and the following parameters will become available.

 — Title: Enter the title of your video.

 — Visible To: Lets you choose who will be able to view this video. The options are Private, 
Public, and Friends.

 — Allow comments: Checking this box allows commenting on your TikTok video. Un-checking 
this box forbids comments on your video.

 — Allow Duet: Checking this box will allow your video to be used side-by-side with a video from 
another creator in TikTok using the Duet function.

 — Allow Stitch: Checking this box will allow your video to be edited and combined with a video 
from another creator in TikTok using the Stitch function.

Dropbox or Dropbox Replay 720p/1080p/2160p
A drop-down menu lets you choose three different resolutions to render to and selects the 
appropriate settings for exporting your program as a file suitable for uploading to Dropbox and many 
other video file sharing services. 

The preset renders a single clip at the timeline’s frame rate and sets the following parameters:

 — Format: MP4

 — Video Codec: H.264

 — Encoding Profile: Auto

 — Audio: Bus 1

 — Audio Codec: AAC

 — Data burn-in: Same as Project

 — Upload directly to Dropbox: When this box is checked, the resulting render will automatically 
upload to your Dropbox account.
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Setting Up Video Sharing Uploads
DaVinci Resolve has account integration with YouTube, Vimeo, Twitter, Dropbox, and Frame.io that 
allows you to render and upload directly to each service. An Internet Accounts panel in the System 
tab of the DaVinci Resolve Preferences lets you sign into your YouTube, Vimeo, Twitter, Dropbox, and 
Frame.io accounts, as well as specify a local cache location for media being synced with Frame.io.

For each service you sign into, a floating window presents the interface in which you’ll need to enter 
your login name and password to enable integration, followed by whatever two-factor identification 
and other required steps are necessary. Once entered, DaVinci Resolve will sign in to each of these 
services automatically when DaVinci Resolve opens.

For each service you sign into, the service’s upload parameters will also be available in the Custom 
Export Video settings in the Deliver page. This allows you to create your own custom file settings that 
can supersede the normal formats allowed by the service presets, while allowing you the convenience 
of the all-in-one uploading and description entry of the preset.

The Internet Accounts panel of the System tab of the DaVinci Resolve Preferences window

NOTE: For Frame.io, the local cache location is used to store clips you import into a 
DaVinci Resolve project from the Frame.io volume in the Media Storage panel of the 
Media page.
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Deliver and Upload to YouTube, Vimeo, Twitter, and Dropbox
When you’ve configured YouTube, Vimeo, Twitter, or Dropbox access in the Internet Accounts panel of 
the System Preferences, the YouTube, Vimeo, Twitter, and Dropbox presets expose an “Upload directly 
to YouTube/Vimeo/Twitter/Dropbox” checkbox, which lets you choose whether or not to automatically 
upload the rendered result.

Choose the desired export options, then click the Add to Render Queue button to add this job to 
the Render Queue as you would with any other export. When that job is rendered, it automatically 
proceeds to upload to the selected video sharing service, and an upload percentage indicator appears 
in the job listing to show how far along this upload is. This upload is done in the background, so you 
can continue working on other things in DaVinci Resolve while the file uploads. If you want to see how 
long the upload will take on any other page, you can choose Workspace > Background Activity to see 
the Background Activity window.

Waiting for your movie to upload

Once the upload is finished, you can view the file directly on the social media site in a web browser by 
right-clicking on the job in the Render Queue and selecting Reveal in Browser.

Review Before Upload
For an extra level of quality control before you send your video out live on the internet, you can select 
Review Before Upload from the Render Queue option menu. This option will pause the automatic 
upload process after the file has been rendered with a message, “Waiting for Upload.” You can then 
right-click on the job in the Render Queue, and select Reveal in Finder to open and review your video. 
Once you’ve made your decision, from that same menu, you can select either Upload to (service name) 
to let your video go, or Cancel Upload if you’ve had second thoughts.

ProRes Master
For quickly outputting ProRes Master files of a whole program. When selected, defaults to rendering 
in single clip mode, with the Format set to QuickTime, the Codec set to Apple ProRes, and the Type set 
to Apple ProRes 422 HQ. Audio defaults to the Codec being Linear PCM and the Bit Depth being 16.

H.264 Master
For outputting H.264 files of a whole program. When selected, defaults to rendering in single clip 
mode, with the Format set to QuickTime, and the Codec set to H.264. Quality, Encoding Profile, and 
Entropy Mode are set to Auto, Passes defaults to Single, and Key Frames default to Automatic with 
Frame Reordering turned on. Audio defaults to the Codec being AAC with the Data Rate set to 320 
Kb/s and the Bit Depth set to 16.
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H.265 Master
For outputting H.265 files of a whole program. When selected, defaults to rendering in single clip 
mode, with the Format set to QuickTime, and the Codec set to H.265. Quality is set to Automatic, 
Encoding Profile is set to Main, Passes defaults to Single, and Key Frames default to Automatic with 
Frame Reordering turned on. Audio defaults to the Codec being AAC with the Data Rate set to 320 
Kb/s and the Bit Depth set to 16.

IMF (Studio Version Only)
A drop-down menu to the right of this preset provides options for Generic, 20th Century Fox, and 
Netflix-qualified presets. This preset is for facilities that deliver IMF files as digital-only deliverables. 
A Preset Type drop-down lets you choose the appropriate settings to populate the various locked IMF-
specific parameters that appear.

Frame.io
A Frame.io preset at the top of the Deliver page’s Render Settings panel lets you render and upload 
a program for review. All options in the Render Settings panel update to present suitable controls 
for this process. At the bottom of the Render Settings list, an “Upload directly to Frame.io” checkbox 
lets you choose whether or not to upload the rendered result. A Description field lets you add a 
description to be uploaded along with the rendered media.

Choosing the Frame.io preset

When you choose the Frame.io preset, the Location field turns into a Frame.io field, and the Browse 
button lets you choose a project and folder path to which to upload the exported result.
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Choosing a Frame.io account to deliver a program to

When you export to Frame.io, the available choices in the Resolution, Format, Video Codec, and Type 
drop-down menus are limited to those that are most suitable for Frame.io file sharing. Choose the 
desired export options, then click the Add to Render Queue button to add this job to the Render 
Queue as you would with any other export. When that job is rendered, it automatically proceeds to 
upload to Frame.io, and an upload percentage indicator appears in the job listing to show how far 
along this upload is. This upload is done in the background, so you can continue working on other 
things in DaVinci Resolve while the file uploads. If you want to see how long the upload will take on any 
other page, you can choose Workspace > Background Activity to see the Background Activity window. 

For more information about Frame.io integration, see Chapter 13, “Frame.io and Dropbox Replay 
Integration.”

Final Cut Pro 7 or X XML
A drop-down menu attached to this preset lets you choose from two different XML formats to be 
exported along with the media you’re rendering:

 — Selects the appropriate settings for projects that were sent from Final Cut Pro 7 to DaVinci Resolve 
using XML. This is meant for situations when you’re rendering media intended for a return trip to 
Final Cut Pro (by exporting an XML file from the Edit page). Renders Individual Clips, the “Codec” 
setting on macOS, defaults to Apple ProRes 422 (HQ), Output Size defaults to the current Timeline 
Resolution (as set in the Master Settings panel of the Project Settings), and Use Unique Filenames 
is turned on. 

When you choose this preset, an XML of the timeline is automatically exported along with the 
media, with path names that reflect the rendered clips.

 — Selects the appropriate settings for projects that were sent from Final Cut Pro X to DaVinci Resolve 
using XML. This is meant for situations when you’re rendering media intended for a return trip 
to Final Cut Pro X (by exporting an FCPXML file from the Edit page). Renders Individual Clips, the 
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“Codec” setting on macOS, defaults to Apple ProRes 422 (HQ), Output Size defaults to the current 
Timeline Resolution (as set in the Master Settings panel of the Project Settings), and Use Unique 
Filenames is turned on. 

When you choose this preset, an XML of the timeline is automatically exported along with the 
media, with path names that reflect the rendered clips.

Premiere XML
Selects the appropriate settings for projects that were sent from Premiere Pro to DaVinci Resolve 
using XML. This is meant for situations when you’re rendering media intended for a return trip to 
Premiere Pro. Renders Individual Clips, the “Codec” setting on macOS defaults to Apple ProRes 422 
(HQ), Output Size defaults to the current Timeline Resolution (as set in the Master Settings panel of 
the Project Settings), and Use Unique Filenames is turned on. 

When you choose this preset, an XML of the rendered timeline is automatically exported along with 
the media, with path names that reflect the rendered clips.

Avid AAF
Selects the appropriate settings for projects that were sent from Avid Media Composer or Symphony 
to DaVinci Resolve using AAF. This setting is NOT for exporting to Pro Tools. This is meant for 
situations when you’re rendering media intended for a return trip to Media Composer (by exporting 
an AAF file from the Edit page). The “Codec” setting defaults to DNxHR 444 12 bit, Output Size defaults 
to the current Timeline Resolution (as set in the Master Settings panel of the Project Settings), and 
Render Clip with Unique Filename is turned on. 

When you choose this preset, an AAF of the timeline is automatically exported along with the media, 
with path names that reflect the rendered clips.

Pro Tools
As of DaVinci Resolve version 16, Pro Tools export has been dramatically improved. This preset 
presents the appropriate options for exporting a specifically formatted AAF project file, linked audio 
files, and a linked reference video file to Pro Tools, or any application capable of importing a Pro Tools 
formatted AAF file.

When exporting using the Pro Tools preset, you must use the AAF file that’s automatically created and 
written to the target location, because it’s formatted specially for Pro Tools and it contains path names 
reflecting the rendered clips. Do not export an AAF using the File > Export AAF/XML command, as this 
will not provide the correct exchange file for Pro Tools, and it won’t work correctly.

When you use the Pro Tools preset, DaVinci Resolve outputs the following:

1 What you choose in the Codec drop-down menu of the Audio panel dictates whether you export 
the audio from the Timeline as a collection of files that link to a separate AAF, or an AAF with audio 
file embedded within as a single deliverable.

 — Choose Linear PCM to export individual files linked to a separate AAF interchange file

 — Choose Embedded in AAF to export an AAF with embedded Broadcast WAV audio files within 
it as a single deliverable

Whether you export separate files or a single embedded AAF deliverable, each of the audio 
clips in the current Timeline can be exported as individual mono or multichannel audio files. 
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The standard mono round trip export from DaVinci Resolve to Pro Tools is the default setting, with 
the “Render one track per channel” box checked in the Audio tab of the Pro Tools Render Setting. 
With this option, a 5.1 polyphonic .wav file would be exported as six individual mono .wav files.

If the “Render one track per channel” box is unchecked, DaVinci Resolve will output multichannel 
polyphonic .wav files instead. If you do this, it’s important to check in advance that Pro Tools 
supports the particular multi-channel formats you want to export before committing to 
this workflow.

Each exported file contains every audio channel from the source media, regardless of channels 
that have been been muted in the audio panel of Clip Attributes. This means no matter how the 
video editor organized the channels of audio in the Timeline, you’ll always deliver every channel of 
each audio clip to whomever is doing your audio postproduction.

2 You can also choose to include handles using the “Add X frame handles” option in the Advanced 
Settings of the Video panel to add extra frames to the beginning and end of each exported audio 
clip. This will provide needed editing flexibility to whomever is refining your audio.

3 The type of audio file that’s exported is determined by your choice of video format in the 
Video panel:

 — If you choose the MXF OP-Atom video format, then MXF audio files will be exported.

 — If you choose the QuickTime format, then Broadcast Wave files will be exported.

4 All video in your timeline will be rendered and output as a single reference movie, in the format 
that’s selected in the Video panel, with all effects and titles baked in. Subtitles can also be burned 
into the reference movie or exported as a file. If you want to provide a window burn, you can 
enable visible metadata using the Workspace > Data Burn-In window. If you do not wish to export 
a reference movie, you can uncheck the Export Video box in the Video panel.

When you output using the Pro Tools preset, an AAF of the audio tracks of the current Timeline is 
exported that’s formatted for import into Pro Tools, or any other digital audio workstation (DAW) 
software that’s compatible with the Pro Tools style of AAF import.

 — Exported audio files have the file name and timecode of the source media they were extracted 
from, to enable relinking to the source media in Pro Tools, if necessary. In the case of Video+Audio 
files that have been synced in DaVinci Resolve, exported audio files are given the timecode and 
name of the synced audio source file, not that of the video clip.

 — Each audio track exports whatever custom name you may have given it, for use by Pro Tools.

 — All track and clip volume automation is exported, with all keyframes.

 — iXML metadata is also exported, including channel names when available.

IMPORTANT: When you export to Pro Tools in the Deliver page, audio effects are neither 
exported nor baked in, which means that FairlightFX, EQ, Compression, Pitch, and Elastic 
Wave effects will be ignored. If you are experiencing problems with imported AAF files, 
check to see if there are audio effects or audio compound clips in the Timeline, and replace 
any you find with duplicates of the same audio clips that have no effects.
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Audio Only
This preset is specifically for rendering an audio-only media file from the Timeline. Video rendering 
is disabled, and this preset defaults to rendering the Main 1 bus as a single clip, rendering one track 
per channel using the MXF OP-Atom format set to the Linear PCM codec, at 16-bits. However, the 
QuickTime, MP4, and WAV formats are also available, and you can also render 24- or 32-bit output. 
Additionally, you have the option to render other Mains or Submixes, or to choose a specific Timeline 
Track to render. Finally, you can choose to render the current program as Individual Clips.

Creating and Using Your Own Presets
If there is a particular group of settings that you find yourself using repeatedly, you can turn it into a 
custom Easy Setup, for easy recall.

To create a new Easy Setup:

1 If you want to start from scratch, make sure to choose Custom from the preset panel to unlock 
every setting in the Render Settings pane.

2 Choose the particular settings you require in the Video, Audio, and File panels for your new preset.

3 Open the Render Settings Options menu, and choose Save as New Preset.

4 Type a name into the “Render Preset” dialog, and click Save. The new preset now appears in the 
Preset panel.

To load a preset:

 — Click any preset. Every setting in the Render Settings pane updates to reflect the 
preset you selected.

To change a custom preset that you’ve created

 — Click a preset you want to change, make whatever changes you need to in the Video, Audio, and 
File panels, then click the Render Settings Option menu, and choose Update Current Preset.

To delete a custom preset that you’ve created:

 — Click a preset you want to delete, then click the Render Settings Option menu, and choose 
Delete Current Preset.

Choosing a Location to Render
The first decision you have to make when rendering your output is where it’s going to be rendered. 
Accordingly, this is the first set of controls appearing at the top of the Render Settings parameters.

 — Filename: A preview of what the file name will be based on the settings found in the File panel 
described later. The Custom/Timeline name and File suffix fields, as well as the “Use x digits in the 
filename” settings all determine what name appears here. The editable portions of this filename 
preview can also be edited here.

 — Location: Click the Browse button to choose a directory in which to write the media being 
output by DaVinci Resolve. After you’ve selected a directory, the path name appears in the 
“Render job to” field.

3993Deliver | Chapter 187 Rendering Media



Single Clip vs. Individual Clips
While there are numerous options available in the Render Settings of the Deliver page, there are 
basically two overarching ways you can render your project, depending on which of the “Render” radio 
buttons you click in the Output group.

Render a single clip or individual clips

Single Clip
When you select the Single clip option, you’re setting up a render wherein all clips in the session are 
output together, as a single media file in whatever format you choose. This means you’ll be rendering 
the selected range of the session to a single MXF or QuickTime file, or as a single collection of 
image sequences.  

 — Timecode: The timecode that’s written out is dictated by the “Start timeline timecode at” setting 
of the timeline being rendered. Media files contain a continuous timecode track, while image 
sequences have timecode written into each frame’s data header, and integrated into the file name 
(as a frame count). 

 — Frame Rate: If you’re rendering a project that uses mixed frame rates, rendering to a single clip 
converts every clip in the entire session to the project frame rate, using either the project-wide or 
clip specific “Retime process” setting.

 — Effects: Most effects are “baked into” the rendered output when you render a single clip.

IMPORTANT: Whenever clip filtering is enabled (via the drop-down menu to the right of 
the Clips button), Single Clip rendering cannot be selected. You can see if clip filtering is 
enabled by an orange line underneath the Clips button in the UI toolbar.

Individual Clips
Selecting the Individual clips option sets up a render where each clip is rendered as an individual 
media file in whichever format you choose. The result will be a collection of as many media files as 
there are clips in the range you’ve selected to render. 

 — Timecode: The timecode written to each clip is cloned from the original source media, making it 
easy to reconform media for projects being passed between DaVinci Resolve and NLEs.

 — Frame Rate: If you’re rendering a project that uses mixed frame rates, rendering to source 
renders each clip at its own individual frame rate, to accommodate round-trip workflows.

 — Effects: You can choose whether any timeline-based effects are either ignored or “baked into” the 
individual clips by checking/unchecking the Render Timeline Effects box.

 — Resolution: You can choose whether the individual clips are rendered at the timeline size or their 
original source resolution by checking/unchecking the Render at Source Resolution box.
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All Other Render Settings for Output
This section covers the different render settings that are available for customizing your output. 
Depending on which Render Setting mode you chose, some of these may be hidden, but this section 
covers the full list found in the Advanced panel of controls. 

If you choose one of the Easy Setups, then some of these settings will be locked, and others will be 
editable, depending on the requirements of that setup. If none of the Easy Setups is suitable for the 
task at hand, you can leave the Easy Setup drop-down menu set to none, and manually choose the 
necessary settings for the task at hand.

Video Panel
This panel contains all video-oriented parameters.

Format and Codec Controls
These top-level parameters let you choose whether or not to render video, and which format to render it 
to. Depending on which Format, Codec, and Type you choose, other options may or may not appear.

 — Export Video: Turn this checkbox on to render the source video. Turn this checkbox off if you 
want to render the source audio all by itself; this disables all video controls, and shows an Audio 
Format drop-down menu in the audio section of settings.

 — Format: A drop-down menu that gives access to the container formats that are currently 
available on your system. The available options depend on whether you have Final Cut Pro and 
QuickTime installed, and on the operating system you’re using. This list is constantly growing, 
as new file formats are added over time, so be sure to check each new version for the latest 
supported formats.

 — AVI: A now-deprecated file-based media format that, despite its age, remains popular with 
Windows applications. Supports delivery using the Cineform, Grass Valley HQ and HQX, and 
Uncompressed RGB and YUV codecs.

 — Cineon: An older uncompressed image sequence format developed by Kodak, designed for 
film scanning and digital mastering, which delivers RGB 10-bit.

 — DCP: Native DCP encoding and decoding for creating unencoded DCP files only. If you 
have a license for Frauenhofer’s EasyDCP, a setting in the Configuration panel of the 
System Preferences enables you to choose whether to use EasyDCP (for creating encrypted 
DCP output), or the native DaVinci Resolve encoding.

 — DPX: An uncompressed image sequence format favored by the film industry for mastering 
and delivery for DCDM mastering, which can be delivered as RGB 10-, 12-, 16-bit integer and 
half float, or RGBA 8-bit.

 — easyDCP: (when installed) An option that allows you to master a DCP or IMF directly 
from DaVinci Resolve in conjunction when you have an installed license of Fraunhofer’s 
EasyDCP software.

 — EXR: The OpenEXR format is a high-dynamic-range image sequence format developed 
by ILM for applications requiring high quality and multiple channels. Used for outputting 
ACES and HDR deliverables. You can deliver to a variety of RGB Half and RGB Float settings. 
When choosing the RGB half (DWAA) or (DWAB) compression codecs, an additional 
“Compression level” setting appears that lets you choose how much compression to apply.
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 — IMF: A native IMF encoding option that lets you export to the SMPTE ST.2067 Interoperable 
Master Format (IMF) for tapeless deliverables to networks and distributors, with support for 
encoding of JPEG2000 using a library licensed from Kakadu software. No additional licenses 
or plugins are required to output to IMF. The IMF format supports multiple tracks of video, 
multiple tracks of audio, and multiple subtitle and closed caption tracks, all of which are meant 
to accommodate multiple output formats and languages from a single deliverable. This is done 
by wrapping a timeline’s different video and audio tracks (media essences) and subtitle tracks 
(data essences) into a “composition” within the Material eXchange Format (MXF).

 — JPEG 2000: DaVinci Resolve 15 introduced support for the encoding and decoding 
of JPEG2000 using a library licensed from Kakadu software. This includes a complete 
implementation of the JPEG2000 Part 1 standard, as well as much of Parts 2 and 3. JPEG2000 
is commonly used for IMF and DCP workflows.

 — MJ2: The Motion JPEG 2000 format. DaVinci Resolve 15 introduced support for the encoding 
and decoding of JPEG2000 using a library licensed from Kakadu software. This includes a 
complete implementation of the JPEG2000 Part 1 standard, as well as much of Parts 2 and 3. 
JPEG2000 is commonly used for IMF and DCP workflows.

 — MP4: Dedicated MP4 encoding lets you export H.264-encoded movies.

 — MXF OP–Atom: A simple standard for the Material eXchange Format, a file-based media 
format, that’s often used when delivering DNxHD. This version conforms to the SMPTE 390M 
standard, and can deliver using the DNxHD, DNxHR, Kakadu JPEG 2000, NTSC and PAL Avid, 
RGB Avid 10-bit, and XDCAM MPEG2 codec options.

 — MXF OP1A: A version of the Material eXchange Format that conforms to the SMPTE 378M 
standard, and can deliver using the 1080i Avid 8-bit, DNxHD, DNxHR, Kakadu JPEG 2000, NTSC 
and PAL Avid, RGB Avid 10-bit, Sony MPEG4 422 and 444, and Sony XAVC Intra CBG and VBR, 
and XDCAM MPEG2 codec options.

 — QuickTime: Apple’s file-based media format, used when delivering Apple ProRes, DNxHD or 
DNxHR wrapped in QuickTime, GoPro Cineform RGB 16-bit and YUV 10-bit, Grass Valley HQ 
and HQX, Kakadu JPEG 2000, H.264, HEVC, H.265 (single or multi-pass), Photo JPEG, Kakadu 
JPEG 2000, Uncompressed 8- and 10-bit formats with ARGB/BGRA/RGB/YUV channel orders, 
and VP9 at 8-, 10-, and 12-bits.

 — TIFF: “Tagged Image File Format,” an image sequence format compatible with many desktop 
video applications on many platforms and is also used when delivering for DCDM mastering.

 — Codec: A drop-down menu that lets you choose from a selection of codecs that are available to 
the format you’ve selected above.

 — Type: Different codec options may also present different bit depth and color space combinations, 
as well, which are available from this menu.

 — Maximum Bit Rate: (Does not appear for all codecs) Codecs such as Kakadu JPEG 2000 let you 
specify a maximum bit rate, in Mbits per second, with which to encode the delivered video.

 — Field rendering: If you’re processing interlaced source material, this checkbox sets 
DaVinci Resolve to render each field individually before reintegrating them back into a single 
frame, in order to process clips most accurately with filtering operations that would otherwise 
violate field boundaries and cause problems. If you’re not rendering interlaced media, you should 
leave this checkbox turned off, as it is more processing intensive.

 — Export HDR10 Metadata: (Available in Single clip mode if HDR10+ is enabled in Project Settings) 
Exports HDR10 metadata to the rendered file when you’re doing an HDR workflow.
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 — Embed HDR10 Metadata: (Available in Single clip mode if HDR10+ is enabled in Project Settings) 
Exports HDR10 metadata to the rendered file when you’re doing an HDR workflow. Embeds 
HDR10 metadata within the exported media of selected formats.

 — Embed HDR Vivid Metadata: Exports HDR Vivid metadata to the rendered file when you’re doing 
an HDR workflow. Embeds HDR Vivid metadata within the exported media of selected formats.

 — Render at Source Resolution: (When rendering Individual Clips) This checkbox lets you render 
each clip at the same resolution as its source media file, letting you preserve mixed frame sizes for 
final delivery.

 — Resolution: The output resolution for rendering. This setting defaults to the current resolution 
of the project as set in the Master Settings panel of the Project Settings, modified by whatever 
transforms are applied in the Sizing palette in Output mode. However you can change the 
resolution here if you need to output at a different resolution. Using this setting, you can queue 
up different render jobs at different resolutions, in order to output both HD and SD resolution 
media in the same render session, for example. Some file formats require specific resolutions, in 
which case the Output Size settings will be automatically set to the necessary resolution.

 — Frame rate: (When rendering Single Clip) This setting is typically identical to the “Timecode 
calculated at” frame rate in the Master Settings panel of the Project Settings. However, you may 
wish to set this to a variation of the current conformed rate, for example choosing from between 
23.98 or 24 fps. Doing so will adjust the metadata written within the file, which is used to aid 
playback for the range of systems available worldwide. 

 — 3:2 Pulldown Insertion Options: Starting with DaVinci Resolve Studio 12.5, you have the 
option of outputting either 29.97 or 30 fps media with 3:2 pulldown insertion if your project’s 
playback frame rate is either 23.98 or 24 fps. To output 29.97 media, the project must be 
23.98 fps; simply choose (23.976 3:2) from the Frame rate drop-down. Projects with 24 fps 
frame rates can only be output at 30 fps.

 — Chapters from Markers: (QuickTime or MP4 only) Embeds chapter points in the rendered file 
corresponding to the marker’s position on the Timeline of the selected marker color.

 — Export Alpha: (When rendering Individual Clips) Turning this checkbox on results in alpha 
channels found in each clip’s source media file being output to each delivered clip, as well as alpha 
information that you’re creating in DaVinci Resolve and inserting into that clip via the Alpha output 
of the Color page Node Editor being output to each delivered clip.

 — Alpha Mode: (When rendering Individual Clips) Lets you choose how to export alpha channels 
when Export Alpha is enabled. You can choose Straight or Premultiplied.

 — Render Stereoscopic 3D: (Only appears if there are stereo clips in a timeline) Three options let 
you choose how to render stereoscopic timelines, rendering just one eye’s worth of media at a 
time, or rendering a single set of stereo media in one of four ways, depending on the option you 
choose from the “Both eyes as” drop-down menu.

 — Left eye: Lets you render only the left-eye media from a stereo timeline.

 — Right eye: Lets you render only the right-eye media from a stereo timeline.

 — Both eyes as: Lets you select from four ways of rendering the left and right eyes of stereo 
media as a single set of media files. “Separate files” lets you output both the left-eye and right-
eye media as individual media files, all at once. Side-by-side, Line-by-Line, and Top-Bottom let 
you output frame-compatible media that can be output to stereo-capable displays. Anaglyph 
lets you output a traditional anaglyph red/cyan stereo image for viewing on any display using 
red/cyan glasses.
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 — Use Constant Bit Rate: If the Format and Codec you’ve specified allows you to switch 
between variable and constant bit rate output, this checkbox lets you force video to render at a 
constant bit rate.

Optional MP4, H.264, H.265, VP9, or HEVC Controls
If you choose MP4 as the format, or QuickTime with H.264, H.265, or VP9 as the codec, additional 
options appear, described below. Workstations using NVIDIA GPUs that offer NVENC will present 
alternative accelerated options, while other workstations offering QuickSync hardware encoding 
instead will be able to use that option.

 — Use hardware acceleration if available: DaVinci Resolve supports QuickSync hardware 
encoding of H.264 and HEVC, if available on your workstation.

 — Quality: If the currently selected option in the Render to drop-down menu has options for 
changing the compression quality, this drop-down menu lets you choose the quality you want to 
use. Otherwise, it’s disabled.

 — Restrict to X Kb/s: You can choose Automatic, or select a maximum data rate with 
which to export.

 — Encoding Profile: A drop-down that lets you choose among different encoding profiles, each 
of which has been optimized for different purposes. The tradeoff is between quality and 
computational intensity for encoding and playback. The available options are:

 — Auto: Automatically selects an encoding profile.

 — Base: For H.264, intended for video conferencing and mobile phone use; highly compressed.

 — Main: For H.264, intended for SD analog transmission. For H.265, intended for the 
compression of 4:2:0 video at up to 4K 60fps with a bit depth of 8-bits per channel.

 — Main10: (H.265 only) Intended for the compression of 4:2:0 video at up to 4K 60fps with a bit 
depth of 10-bits per channel.

 — Main 4:2:2 10: (H.265 only) Intended for the compression of 4:2:2 video at up to 4K 60fps with 
a bit depth of 10-bits per channel.

 — High: For H.264, intended for Blu-Ray and HD transmission.

 — Entropy Mode: (called Entropy Coding Mode for compatible Nvidia GPUs) A drop-down that lets 
you choose which algorithm the encoder should use for compression. The choices are:

 — CALVC (context-adaptive variable-length encoding): A lower-quality algorithm that’s less 
computationally intensive to process and play.

 — CABAC (context-based adaptive binary arithmetic coding): A higher-quality algorithm 
that yields better visual quality at lower bandwidth, at the cost of being more computationally 
expensive to process and play.

 — Multi-pass encode: (Available for QuickTime H.264 and H.265) You can choose between Single 
and Multi-pass encoding. Single pass is faster, but multi-pass yields superior results when quality 
is important. When you enable Multi-pass, the number of passes performed is automatic.

 — Key Frames: (Available for QuickTime H.264 and H.265) You can choose Automatic, or select a 
duration for manual keyframe insertion.

 — Frame Reordering: (Available for QuickTime H.264 and H.265) On by default, Frame Reordering 
enables the encoding of B frames to improve the quality of the resulting compressed movie file. 
Turning off Frame Reordering will speed encoding performance at the expense of visual quality.
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 — Rate Control: (Available for compatible NVIDIA GPUs) Provides six options for controlling 
Encoding Profile and Entropy Mode.

 — Lookahead: (Available for compatible NVIDIA GPUs) Lets you specify how many frames for the 
encoder to examine in advance of compression.

Optional DCP and IMF Controls
If you choose DCP or IMF as the Format, additional options appear, described below.

 — Use interop packaging: (DCP only, located under Type parameter) Lets you create an Interop 
DCP package, based on an earlier standard of DCP delivery that is not forward compatible with 
SMPTE DCP packages. 

 — Package Type: (IMF) Defaults to App2 Extended (App2e), for encoding JPEG 2000 up to 4K.

 — Bit Depth: (IMF) The bit depth of the encoded IMF video.

 — Encoding Profile: (IMF) A drop-down that lets you choose among Auto, IMF, and Broadcast.

 — Encoding Level: (IMF) Provides different choices based on what is selected in Encoding Profile.

 — Maximum bit rate: (DCP, IMF) Lets you choose how much to compress the result.

 — Lossless Compression: (IMF) Lets you choose to encode using lossless compression.

 — Slope-Rate Control: (DCP, IMF) A checkbox lets you specify lossless compression.

 — QStep: (DCP, IMF) Lets you choose either automatic or manually specified DCP quantization levels 
at which to compress the video signal when using the Kakadu JPEG 2000 encoder.

Advanced Controls
An advanced settings disclosure button hides the following additional controls, by default.

 — Pixel aspect ratio: Lets you override the Project Settings and change the PAR of the rendered 
output to either Square or Cinemascope.

 — Data levels: Defaults to “Auto,” which simply renders all clips with the data level appropriate to 
the currently selected codec in the “Render to” drop-down menu, which is usually the preferred 
behavior. Choosing one of the other options (“Video” or “Full”) outputs all clips using the selected 
data range. For more information, see Chapter 9, “Data Levels, Color Management, and ACES.”

 — Retain sub-black and super-white data: Turning this checkbox on lets you choose to output 
media files that preserve overshoots and undershoots, data that’s above the maximum and 
minimum data levels of the data level you’ve selected, assuming this is supported by the video 
format and codec you’re exporting to. Otherwise, DaVinci Resolve clips these “out-of-bounds” 
parts of the signal in an effort to keep your deliverables from violating whatever QC standards 
you’re adhering to in your grade.

 — Color Space Tag: A drop-down menu that lets you choose a color space to embed as metadata in 
the rendered file. This setting defaults to the Output Color Space if your project’s color science is 
set to DaVinci YRGB Color Managed, or the ACES Output Device Transform if your color science is 
set to ACEScc or ACEScct.

 — Data burn-in: A drop-down menu that defaults to “Same as Project,” which leaves the current 
Data Burn In palette settings enabled while rendering, inserting a window burn into the media 
being output. Choosing “None” disables window burns while rendering. Note that when rendering 
as Individual Source Clips, individual clip burn in presets can be assigned if they’ve been created in 
the Data Burn In palette. 
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 — Use optimized media: When this checkbox is turned on, DaVinci Resolve will use optimized 
media, when available, to do the final render, to save time. If your media has been optimized to 
the same format as the one you’re outputting to (or better), this is convenient. However, if you’ve 
optimized to a lower quality format than what you’re outputting to, you should turn this checkbox 
off to force DaVinci Resolve to process all clips using the original media, guaranteeing the best 
quality available.

 — Use render cached images: When this checkbox is turned on, DaVinci Resolve will write media 
from the cache to the files being output to save time. If you’re caching using the same media 
format you’re outputting to (or better), this can be convenient. However, if you’re caching in a 
lower-quality format than the one you’re outputting to, you’ll want to turn this checkbox off to 
force DaVinci Resolve to process all media as it’s being rendered, writing at the maximum quality 
you’re outputting to.

 — Enable flat pass: Three options let you choose whether or not to render each clip with 
its grade applied.

 — Off: DaVinci Resolve always applies each clip’s grade when rendering.

 — With clip settings: For each version of a clip, the system will check that version’s pass 
flat flag. If it’s turned on, the system disables color correction for that version of the clip. 
Otherwise, that version will be rendered with its grade intact. Versions can be individually 
flagged by right-clicking a clip’s thumbnail in the Timeline, choosing the submenu of the 
version you want to flag, and choosing Enable Flat Pass.

 — Always On: When checked, DaVinci Resolve disables the grade of every clip being rendered.

 — Trigger script at: You now have the option of triggering a script to execute before or after 
rendering a timeline, by checking the “Trigger script at” box.

 — Start: Executes the script before the render job.

 — End: Executes the script after the render job.

 — Script: Chooses the specific script to run. You can select the specific script to execute using 
the corresponding drop-down menu. Scripts must be written for the Resolve scripting 
framework in either Python or Lua, and placed in the following directory:

 — MacOS: /Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/
Scripts/Deliver/

 — Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Fusion\Scripts\Deliver

 — Linux: /opt/resolve/Fusion/Scripts/Deliver

 — Disable sizing and blanking output: When turned off, Output Blanking to create letterboxing 
or pillarboxing is “baked” into the output, as are all sizing adjustments made on the Cut, Edit, and 
Color pages, including Image stabilization. 

When turned on, Output Blanking, Cut and Edit page sizing adjustments, Color page Input and 
Output Sizing, and Image Stabilization are disabled. Rendered media is rendered either at the 
source resolution if “Render at source resolution” is enabled in individual clips mode, or to the 
currently specified resolution of the Timeline or project. If you’re outputting via Final Cut Pro or 
Premiere Pro XML, or Avid AAF, sizing adjustments are output to the XML or AAF files that are 
created for purposes of round-tripping these adjustments as editable metadata back to an NLE.

Be aware that “Disable sizing and blanking output” does not disable any transform operations 
that happen within the Fusion page, nor does it disable transforms happening as a result of an 
Open FX or Resolve FX plugin applied to one or more clips in the Cut, Edit, or Color pages. All of 
these effects will continue to be rendered into the final output.
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 — Force sizing to highest quality: If you’ve been working with the “When resizing and scaling:” 
option set to Bilinear to improve performance when working on slower workstations, turning this 
checkbox on automatically renders all clips using the “Uses Sharper filter” setting of the Image 
Scaling panel in the Project Settings. For more information, see Chapter 4, “System and User 
Preferences.”

 — Force debayer res to highest quality: When rendering camera raw media formats that allow 
variable quality debayering, it’s common to lower the debayering quality to improve real time 
performance while grading. Turning this checkbox on guarantees that media will always be 
rendered at the highest available quality, saving you from forgetting to manually change the 
debayer setting back when setting up a render at 3am.

 — Add X frame handles: (When rendering Individual Clips) Lets you specify front and rear handles 
to be output in frames. This is particularly useful in round trips, when the finishing editor might 
want additional handles with which to roll edit points or add transitions while fine-tuning the 
graded edit.

 — Tone Mapping: (Available in Single clip mode if Dolby Vision or HDR10+ is enabled in Project 
Settings) When set to None, the timeline is output using the current color management settings. 
When set to either Dolby Vision or HDR10+, you can choose to output the timeline at a specific 
peak nit level, color space, gamma, and Data Level using either the Dolby Vision or HDR10+ 
metadata available to guide the tone mapping operation you’ve selected. This makes it easy to set 
up multiple jobs to output HDR outputs at varying levels, as necessary.

 — Bypass re-encode when possible: (Single Clip mode only) Turning this checkbox on makes it 
possible to do a direct copy of the video essence of video items in the Timeline, directly from the 
source media to the file being output, when the selected Format, Codec, and Type matches the 
source. This also preserves alpha channel data for compatible formats.

Bypass re-encode eliminates the need to re-encode video media, preserves quality, and speeds 
up the output process dramatically, but it only works for clips in the Timeline to which no 
additional effects have been added. Doing any grading, adding a Resolve FX plugin, adding any 
overlapping effects or compositing to clips in the Timeline, resizing or stabilizing clips or altering 
the output sizing of the Timeline, and adding Fusion effects will all necessitate re-encoding the 
entire clip in order to process these effects. Transitions will require processing, but only for the 
duration of each transition.

There are many situations where this is valuable:

 — Fast output of simple edits: You’ve edited a simple cuts-only promo using footage cut from 
a previously rendered program using QuickTime ProResHQ 422 media, and you’re exporting 
to the exact same format. You can output all of the media very quickly using Bypass re-encode 
when possible.

 — Fast output of previously output timelines with small changes: You need to replace a few 
shots in an effects-intensive program that’s already been output. You can import the media 
file that was output into a new timeline, replace only the required shots with new media. 
DaVinci Resolve will do a direct copy of all previously rendered media, while re-encoding only 
the new clips with whatever effects and grading they contain. This lets you quickly re-output a 
high-quality master file, while preventing you from needing to re-render the entire program.

 — Fast output of previously output timelines with new audio mixes: You’ve placed a 
previously rendered Video+Audio clip onto a timeline and edited a new audio mix clip to 
replace the old audio mix. In this situation, a new Video+Audio file will be quickly written with 
the new audio, but the video component of that file won’t be re-encoded, again resulting in a 
fast export at the highest quality.
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TIP: For a list of which video formats are compatible with Bypass Re-encode on macOS, 
Windows, and Linux, as well as which formats are compatible with alpha channels, 
see the “Supported Codec List” at the DaVinci Resolve Support page, located at  
https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion.

DCP and IMF Composition Settings
If you’ve selected either DCP or IMF from the Format, a Composition Settings group appears with the 
following parameters when you click the disclosure control, which let you populate standard DCP and 
IMF composition metadata:

 — Composition name: The name of the exported composition.

 — Issuer: The organization providing the composition.

 — Use current date: A checkbox that lets the current date be used as the Issue date automatically.

 — Issue date: The date the composition is issued.

 — Content kind: A drop-down provides a list of acceptable choices for defining the content.

 — Content version label: Meant to identify the version of the content being provided.

 — Annotate xml using composition name: Auto-populates Asset Map, Composition Playlist, and 
Packing List with data from the project. Otherwise these three fields are manually editable.

 — Annotate reel index as suffix (DCP only): Auto-populates Reel Annotation with data from the 
project. Otherwise this is manually editable.

 — Annotate media using filename: Auto-populates Main Video Track and Audio Track 1 with data 
from the project. Otherwise these three fields are manually editable.

Subtitle Controls
The Subtitle Settings group exposes controls governing how to export subtitles in your program:

 — Export Subtitle checkbox: Lets you enable or disable subtitle/closed caption output.

 — Format pop-up: Provides four options for outputting subtitles/closed captions.

 — As a separate file: Outputs each subtitle track you select as a separate file using the format 
specified by the Export As pop-up. A set of checkboxes lets you choose which subtitle tracks 
you want to output.

 — Burn into video: Renders all video with the currently selected subtitle track burned into the 
video.

 — As embedded captions: Outputs the currently selected subtitle track as an embedded 
metadata layer within supported media formats. There is currently support for CEA-608 
closed captions within MXF OP1A and QuickTime files. You can choose the subtitle format 
from the Codec pop-up that appears.

 — Export As: (Only available when Format is set to “As a separate file.”) Lets you choose the subtitle/
closed captioning format to output to. Options include: IMSC1, DFXP, SRT, and WebVTT.

 — Include the following subtitle tracks in the export: (Only available when Format is set to “As a 
separate file.”) A series of checkboxes lets you turn on which subtitle tracks to output.

 — Codec: (Only available when Format is set to “As embedded captions.”) Lets you choose how to 
format embedded closed captions; choices include: Text and CEA-608.
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NOTE: Neither analog (Line 21) nor digital (CEA-708) closed caption output via Decklink or 
UltraStudio is supported at this time.

Audio Panel
This panel contains all audio-oriented parameters.

 — Export audio: Turn this checkbox on to render the source audio, or audio that you’ve 
synchronized in DaVinci Resolve, along with the media being output by DaVinci Resolve.

 — Format: You can choose which format of audio you want to render. Depending on which format 
you choose, different audio codec options will appear below.

 — MXF OP1A(IMF): Generates media files that conform to the OP1a (Operational Pattern 1a) 
SMPTE 378M format of MXF media for file exchange.

 — MXF OP-Atom: Generates media files that conform to the SMPTE 390M format of MXF media 
for file exchange.

 — QuickTime: Exposes all available formats of audio compatible with QuickTime.

 — MP4: Generates media in the MPEG-4 file format.

 — WAVE: Generates media in the WAVE file format.

 — MP3: Generates media in the MPEG-3 file format.

 — Codec: Lets you choose between Linear PCM (the default), AAC audio, IEEE Float, or MP3. AAC 
audio encoding is only available on macOS.

 — Sample Rate: Lets you set the sample rate, in Hz, of the output of the audio.

 — Bit Rate Strategy: (Available for AAC encoding) You can choose among Constant Bit Rate, 
Average Bit Rate, Variable Bit Rate Constrained, and Variable Bit Rate.

 — Quality: (Available for AAC encoding when Bit Rate Strategy is set to Variable Bit Rate) Five 
settings you trade between speed and quality when encoding AAC audio.

 — Data Rate: (Available for AAC encoding when Bit Rate Strategy is set to Constant, Variable, or 
Variable Constrained) Lets you choose the maximum data rate for AAC encoding.

 — Bit Depth: Lets you specify the bit depth at which to output the source audio.

 — Render one track per channel checkbox: This checkbox lets you specify whether you want to 
export each channel as an individual track in the structure of the exported file. Multi-channel 
formats can be specified (2.0, 5.1, etc.), or can be output as flat multi-mono files.

 — Render as discrete audio tracks checkbox: This checkbox is similar to the above, in that it still 
outputs one channel per track. However, discrete tracks have no positioning info, nor do they 
group as multi-channel clips (2.0, 5.1, etc.). For example, a mono file exported with Render one 
track per channel, comes in front and centered. The same file exported as a discrete audio track 
has no built in position information.

 — Output Track #: This drop-down menu lets you choose which Main or Submix bus you want to 
output. A Plus button to the right lets you add additional tracks you want to export in this job, so if 
you want to export multiple Mains or multiple Subs, you can add more Track pop-ups.

 — When you choose a track with multiple channels of audio, a field appears showing how many 
channels will be output; you have the option of using a virtual slider to change how many 
channels are output.
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 — In Single Clip Mode, when you choose “All Timeline Tracks, each audio track in the current 
timeline will be rendered as an individual track in the rendered media file you’re outputting. 
Multi-channel tracks containing multi-channel clips will output audio tracks containing 
the same number of channels in the output media, which means you can output mixed 
combinations of mono, stereo, 5.1 or 7.1, and adaptive audio tracks, and each separately 
rendered audio track will reflect identical channel mappings.

 — Language: (Only available when outputting to the IMF format) This drop-down menu lets you 
choose the language of a particular output track when you’re outputting to IMF. Since IMF files 
can accommodate multiple audio tracks containing different mixes for different regions, it’s 
important to identify each output track you’re outputting by language.

 — Content: (Only available when outputting to the IMF format) This drop-down menu lets you 
choose the content of a particular output track when you’re outputting to IMF. Since IMF files 
can accommodate multiple audio tracks containing different mixes and content, it’s important to 
identify each output track you’re outputting by content.

File
This panel contains all other parameters.

 — Filename Uses: Three options let you automatically name the media file(s) that are 
output automatically.

 — Use Custom Filename: Lets you enter your own name in the Custom name/File prefix field.

 — Use Timeline Name: (When rendering a Single Clip) When this option is selected, the name of 
the Timeline is used.

 — Use Source Filename: (When rendering Individual Clips) When this option is selected, the 
filename of each clip’s corresponding source media file is cloned, and used as the filename 
of media being output by DaVinci Resolve. This is preferred when you’re generating offline 
media for use by an editor that you later want to reconform to the originating DaVinci Resolve 
project. When this checkbox is turned off, you can customize filenames using the other 
options in this section of settings.

 — Custom name: Lets you use custom text to name all rendered files. If you’re not using the source 
filename, and not rendering to a file format that uses timecode, you can enter a filename here. 
When editing the Custom Name or File Prefix (or File Suffix), you can use “metadata variables” 
that you can add as graphical tags that let you display clip metadata. This is especially useful 
when rendering Individual Source Clips. For example, you could add the corresponding metadata 
variable tags %scene_%shot_%take and the File Prefix would be written as “12_A_3” if “scene 12,” 
“shot A,” “take 3” were in the source clip’s metadata. For more information on the use of variables, 
as well as a list of all variables that are available in DaVinci Resolve, see Chapter 16, “Using Variables 
and Keywords.”

 — File suffix: Lets you add custom text and/or metadata variables (described previously) to the end 
of all rendered files.
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 — Use unique filenames: (When rendering Individual Clips, and only when Filename uses is set 
to Custom name) When enabled, additional characters are added to every rendered media file 
to guarantee that each rendered media file has a completely independent name. This prevents 
multiple rendered clips from the same source media file from overwriting one another when 
saved to the same directory. “Uniquely” named clips append the clip name with the track and clip 
number identifying a clip’s position in the currently selected session. For example, a clip that’s 
linked to a media file named “DropThatThingCU.mov,” and edited as the twenty-fifth clip on track 
V2, will be named “DropThatThingCU_V2-0025.mov” when rendered. When enabled, two other 
options are revealed.

 — Use unique filename prefix/Use unique filename suffix: (When Use Unique Filenames is 
on) Radio buttons let you choose whether to add the unique identifier at the beginning or end 
of a clip. Choosing Prefix would result in “V2-0025 _DropThatThingCU.mov,” whereas choosing 
Suffix would result in “DropThatThingCU_V2-0025.mov” when rendered.

 — Add source frame count to filename: (When rendering Individual Clips, and only when Filename 
uses is set to Custom name) When enabled, the source frame number of each clip is appended to 
the end of the rendered file name. This is another way to make sure that multiple rendered clips 
with custom names don’t overwrite one another.

 — Use filename digits: Lets you specify how many digits to use when rendering an image 
sequence, although the specified digits will also be used for any media format. This is particularly 
useful if you’re outputting media to be used by an application that has strict requirements for 
image sequence numbering. Defaults to eight digits.

 — Each clips starts at frame: (When rendering Individual Clips) This permits timecode to be written 
to the header, and frame count to be written to the filename of the image sequences, which is 
ideal for VFX workflows.

 — Start timeline timecode at: (When rendering Single Clip) This option is only available when 
rendering clips in Single clip order. Specifies the timecode that will be written to the media 
being output by DaVinci Resolve. For DPX files, timecode is written into the header data, and 
is simultaneously converted to a frame count that’s inserted into the filename of each frame 
file, which provides a logical count of the frame numbers. For other media formats, timecode is 
written to the appropriate metadata container. You may find it useful to use custom start times, 
for example starting each reel of a project at a particular value, depending on the standards 
employed at your shop.

 — Place clips in separate folders: (When rendering Individual Clips) Useful if you need to preserve 
the filenames of files you’re outputting when the filenames of clips coming from the same source 
media file may cause them to overwrite one another. This option is also commonly used when 
rendering VFX shots for additional post-production work, allowing the VFX department to identify 
clips quickly and distribute the work accordingly.

 — Preserve Source directory levels: (When rendering Individual Clips) Retains a user-specified 
depth of the original directory structure used by a clip’s corresponding source media file, 
recreating it when rendering new files for output. The number you select determines how many 
levels of subdirectories DaVinci Resolve will automatically create within the currently specified 
“Render job to” directory to match the path used by the source files. Defaults to 0, which creates 
no matching subdirectories.
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 — After Head/From Tail: When setting how many directory levels of each clip’s file path to 
preserve (using the “Preserve x levels” parameter), click one of these buttons to specify whether 
that number of path levels is defined relative to the head or the tail of each media file path.

 — Preserved Path: Shows you a preview of the preserved path you’ve set up so you know 
you’ve gotten it right.

 — File Subfolder: (Only appears in Additional Output panels) Lets you specify a subdirectory into 
which to render the media files being output. If the specified subdirectory doesn’t exist, a new 
one with that name will be created within the currently specified “Render job to” directory.

 — Use commercial workflow: (When rendering Individual Clips) Automatically renders every 
version that’s applied to each clip in the session, except for versions that have been flagged using 
the “Render Disabled” flag, found in the Version submenu for each clip in the Timeline. This option 
is typically used when you’ve graded multiple versions of a clip to be used for VFX work, and you 
want to deliver each grade as a separate media file. This is also used when rendering programs 
for commercial broadcast where you have two or more versions of a grade for each scene. When 
using this option, alternate methods of outputting each rendered media file are used, and four 
additional settings are revealed.

 — Alternative pass offset: Lets you separate the timecode values written into each version of a 
clip with an offset. For example, if the default version timecode is 01:00:20:00, and you select 
a 10 minute offset in the Alternative Pass Offset timecode entry, then the second graded 
version of that clip will start at 01:10:20:00, the third version will start at 01:20:20:00, and so on 
until every version is rendered. You can offset the clips by whatever value you like, but the idea 
is to make it easy for editors and VFX artists to find the versions of each grade. If the clips are 
shared with a finishing artist, and they know that each alternate pass is 10 minutes apart, then 
it’s easy for the finisher to change the clip version just by adding 10 minutes to the referenced 
timecode. To simplify the workflow further, you can put separate source reels in separate 
folders using the next three options.

 — Place reels in separate folders: Automatically places all media that’s output using a 
particular reel name into corresponding folders.

 — Place clips in separate folders: Automatically places alternate grades of clips into 
separate folders.

 — Use version name for folders: Labels each folder with the name of the version when using 
the Commercial Workflow option.

 — Render speed: A drop-down menu lets you throttle the speed at which media is rendered. 
Ordinarily you’ll leave this set to the default of Maximum. However, some storage systems that 
are shared by multiple rooms in a facility use storage area networks (SANs) with insufficient 
bandwidth for multiple real-time image streams. DaVinci Resolve’s incredibly fast rendering 
speeds can cause playback problems with other users accessing the SAN if available bandwidth 
is insufficient. In this case, you can throttle the render speed to limit SAN bandwidth usage to 
between 1 to 50 percent of full rendering speed.

 — Disk space currently used: Shows the amount of disk space available on the target volume.

 — Disk space used after render: Shows the new disk usage based on the specified range of the 
current session that you’re rendering.
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Additional Outputs
Each job you create in the Render Settings defaults to a single output. However, you can create 
multiple outputs when you need to deliver multiple versions of media, with individual video 
formats and codecs and different data burn-in settings, to be rendered into individually named 
subfolders (optional). 

This can be useful for setting up multiple rendered passes when your client requires two sets of media, 
for example QuickTime ProRes 422 (HQ) media along with MXF DNxHD media. This is also useful when 
you need to output two sets of media where one has window burns, and the other is clean. 

The menu command for creating an additional output, 
shown next to an existing additional output in panel 2

To add additional outputs in the Render Settings:

 — Choose Create Additional Output from the Render Settings Option menu. A row of numbers below 
the Filename and Location controls let you open each output you create and adjust its settings. 
You can have as many outputs as you require.

To remove an additional output:

 — Open the additional output panel you want to remove, and click the Delete button at the bottom.

How to Avoid Overwriting Clips 
When Rendering Output Media
Three of the options described previously, “Use unique filenames,” “Place clips in separate folders,” 
and “Use commercial workflow,” are all ways of organizing your rendered media to avoid overwriting 
rendered clips that happen to share the same file name. These options are necessary because each 
clip has one logical range of timecode, and because multiple clips often refer to a single source media 
file with one name.
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When rendering a clip, DaVinci Resolve automatically overwrites any other media files that have the 
same name. So, in instances where you’re trying to preserve the previous filename of the source 
media file, or where you’re rendering out multiple versions of the same clip, it’s entirely likely that the 
clips you’re trying to output will overwrite one another, leaving you with the last clip you rendered. 
The three options mentioned previously prevent this in different ways.

Defining a Range of Clips 
and Versions to Render
Once you’ve defined the Render Settings, now you need to decide how much of the Timeline you need 
to render. A Mini-Timeline and Thumbnail timeline are available to help you navigate your project’s 
clips in order to choose which ones you want to render. Track controls let you enable and disable 
whole tracks from being output; for example if you need to render a textless version of a timeline in 
which all the title clips are on track V4, you can disable track V4. Furthermore, you can also use these 
controls to choose which clip versions you want to render.

To render the entire Timeline:

 — Choose Entire Timeline from the Render drop-down in the Deliver page timeline. This option only 
appears if clips are not filtered.

To disable a video or audio track to exclude those clips from being rendered:

 — Click the Video or Audio Disable Track button for the tracks you want to exclude.

To render a filtered subset of clips in the Timeline:

1 Open the Color timeline, if it’s not already shown, and choose an option from the Timeline 
Filter drop-down to the right of the Clips button in the Interface toolbar. 

The contents of the Thumbnail timeline are restricted to show only the clips matching the selected 
criteria. For example, if you’ve already rendered a session, but you’ve since made some changes, 
you can use one of the “Show Modified Clips” options to display only the clips that have changed 
within a particular timeframe. Another possibility is to choose the “Show Unrendered Clips” option 
to show all clips that have not yet been rendered.

2 Choose “All Filtered Clips” from the Render drop-down in the Timeline toolbar.

To clear clip filtering:

Choose All Clips from the Timeline Filter drop-down to the right of the Clips button in 
the Interface toolbar.

To define a continuous range of clips to render:

1 To define the first clip in the range you want to render, do one of the following:

 — Right-click a clip thumbnail in the Thumbnail timeline and choose Mark In.

 — Position the playhead in the Timeline or the Viewer, and press the I key, or right-click the 
Timeline ruler and choose Mark In.
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2 To define the last clip in the range you want to render, do one of the following:

 — Right-click a clip thumbnail (in the Color timeline) or a clip (in the Edit timeline) in the 
Thumbnail timeline and choose Mark Out.

 — Position the playhead in the Timeline or the Viewer, and press the O key, or right-click the 
Timeline ruler and choose Mark Out.

In and Out points appear within the Timeline ruler, and an orange bar shows the range you’ve 
selected to render. The In and Out fields update with the first and last frame numbers, in timecode 
and frame count, and the Duration field updates with the total number of frames you’ll be rendering. 

IMPORTANT: If you’re in Individual Clips mode, In and Out points automatically snap to 
the nearest clip In or Out point in the Timeline. You cannot render partial clips in Individual 
Clips mode, but you may do so in Single Clip mode.

To render a single clip:

 — Open the Thumbnail timeline if it’s not open already, Right-click any clip thumbnail, and choose 
Render This Clip.

 — An orange bar in the Timeline ruler shows that clip is selected for rendering. If you need to render 
several clips individually, you can select each clip one at a time to add as individual jobs to the 
Render Queue.

Choosing Which Versions to Render for Each Clip
By default, the currently selected version that was set in the Color page is rendered for each clip. If you 
want to render a different version, the easiest thing to do is to make sure they’re selected on the Color 
page Timeline before you open the Deliver page.

However, a Versions submenu, within the Thumbnail timeline’s contextual menu for each thumbnail, 
also provides options to manage grade versions. These commands are duplicates of options that are 
available from the Thumbnail timeline of the Color page.

To choose which version to render:

 — Right-click any clip thumbnail in the Thumbnail timeline, and choose a version from 
the Versions submenu.

TIP: You can right-click a clip in the Thumbnail timeline of the Color or Render screen and 
rename any version of a grade. This can assist a facility’s workflow when sharing material 
between suites and applications.
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Using the Render Queue
Once you’ve defined the settings necessary to render the type of media you require, and the range 
of the current session you want to render, you need to add all that information as a job to the Render 
Queue. You can add as many jobs to the Render Queue as you need, depending on what files you 
need to output. 

Each job can have individually specified ranges of clips and individual clip settings, which can include 
different render directories, different formats, resolutions, data levels, burn-in settings, and so on. 
As a result, you can use the Render Queue to queue up the render of multiple sections of the current 
session, or multiple versions of the same media. Furthermore, you can queue up multiple sessions, if 
you have several differently graded sessions.

To add a job to the Render Queue:

1 Select a timeline.

2 Choose the settings you require in the Render Settings, using one of the Presets, or by choosing 
your own custom settings.

3 Choose a range of clips to render using the Deliver page Timeline using the procedures described 
in the previous section.

4 Click the Add to Render Queue button at the bottom of the Render Settings.

5 If you haven’t chosen a location for the render yet, you’ll be prompted to do so now via a File 
Destination dialog, so choose a location and click Ok. If there’s already media in the render 
location you’ve specified, you may also see a dialog telling you “This render may overwrite existing 
clips in this folder.” If you want to continue, click Yes, otherwise click No.

That render setup is now added as a job to the Render Queue, showing the project and timeline name, 
and location path where the render will be written to.

A selected job in the Render Queue

Media Offline Warning in Render Queue

When you attempt to add a job to the Render Queue with a timeline that contains any offline material, 
DaVinci Resolve automatically gives you a warning. You may choose to either cancel adding the job, or 
to add it anyway, knowing you’re about to render one or more offline clips.

Media Offline warning box that appears if your timeline contains 
offline clips or frames and is added to the Render Queue
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To show more details about jobs in the Render Queue:

Click the Render Queue Option menu (at the upper right-hand corner) and choose Show Job Details. 
Each job now lists the frame size, format, frame rate, audio channels and sample rate, and duration 
below the name and location path.

A selected job in the Render Queue with job details shown

To rename a job:

 — Jobs can be given custom names simply by clicking on the default job name ( Job 1, Job 2, and 
so on) and typing a new name of your own. This can be useful for setting up jobs that you may be 
re-rendering over and over as you work on a project.

To start rendering:

1 If you want to restrict rendering to only selected jobs in the Render Queue, then select one or 
more jobs by clicking on one, and then Command-clicking on others to choose discontinuous 
jobs, or Shift-clicking on another to select an entire range of jobs. When you select one or more 
jobs, only the selected jobs will be rendered. If no jobs are selected, then all jobs in the queue will 
be rendered.

2 Click the Start Render button, underneath the Viewer to the right of the interface.

3 If there are jobs in the Render Queue that have already been rendered, a dialog will appear asking 
“Selected items contain already rendered items. Do you want to re-render them?” Clicking Yes will 
re-render all jobs in the Render Queue. Clicking No only renders the jobs that have not yet been 
rendered. Clicking Cancel cancels the entire rendering operation.

Rendering begins, starting with the highest job in the list. The Overall Progress bar starts to fill 
up, from right to left, indicating how much of what’s been queued up has been rendered so far. 
While rendering is in progress, the Start Render button changes to the Stop Render button, which 
can be clicked at any time to halt rendering.

TIP: While rendering is in progress, a small progress bar will appear on the 
DaVinci Resolve icon in the dock of Mac OS X, or on the taskbar of Windows.

To remove jobs from the Render Queue, do one of the following:

 — To clear a specific job: Click the X at the upper right-hand corner of a job’s entry in 
the Render Queue.

 — To clear all previously rendered jobs: Click the Render Queue Option menu (at the upper right-
hand corner) and choose Clear Rendered.

 — To clear all jobs: Click the Render Queue Option menu (at the upper right-hand corner) and 
choose Clear All.
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To change a job that has been rendered to appear unrendered again:

 — Right-click any rendered job, and choose Clear Render Status. You can also select multiple jobs to 
change their rendered status all at once. This makes it easy to re-render the exact same job.

To edit a job that has or has not been rendered:

1 Click the Pencil button in the Render Queue to select it.

Clicking the pencil icon to edit 
a job in the Render Queue

The selected Render Queue’s settings repopulate the Render Settings list, and resets the selected 
range of the Timeline corresponding to that job.

2 Change whichever settings you need to.

3 When you’re finished editing the job, click the Update Job button that appears at the bottom of 
the Render Settings, or you can click Add New Job to create a new job with the changes you’ve 
made, leaving the previous job untouched.

NOTE: If you click the Pencil button again without clicking Update Job, you’ll be prompted 
to Save, Cancel, or Don’t Save.

To review clips that correspond to rendered jobs:

 — To show a rendered clip in the Media Storage browser: Right-click any rendered job, and 
choose Reveal in Media Storage.

 — To show a rendered clip in your computer’s file system (Mac OS only): Right-click any 
rendered job, and choose Reveal in Finder.

Rendering Jobs from 
Multiple Projects at Once
You can also add multiple projects from the currently open PostgreSQL or local project library to the 
render queue all at once. This can be exceptionally useful in situations where you’ve broken a program 
into multiple reels, with each reel being a different project. 

To render output from multiple projects at once:

1 Open each project, set up whatever jobs you want to render in the Render Queue, and save that 
project without rendering.

2 When you’ve set up the last project, click the Render Queue Option menu (at the upper right-hand 
corner) and choose Show All Projects.
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All queued items in projects belonging to the currently selected user (if using a network project 
library) or in the currently specified disk location (if using a local project library) now appear in the 
Render Queue.

3 Click Start Render to begin rendering every job from every project in the queue.

4 When you’re finished, turn Show All Projects off to go back to displaying only the current project’s 
render queue items.

Remote Rendering
If you have multiple DaVinci Resolve workstations on the same network, you can send a job in the 
Render Queue from the workstation you’re using (referred to as the “artist workstation”) to one of 
the “remote workstations” on the network using remote rendering. This lets you use any one of 
your currently unused secondary workstations to render your jobs, while you continue working on 
your main workstation.

In order to use remote rendering, you must adhere to the following three criteria:

 — Both the artist workstation and the remote workstation must have DaVinci Resolve Studio 
installed. Remote rendering does not work with the free version of DaVinci Resolve.

 — Both the artist workstation and the remote workstation can use the same shared network project 
library, or any other Postgres project library that is connected to either one of the machines, or to 
a dedicated Remote Project Library Server. For more information on setting up and using shared 
project libraries, see Chapter 193, “Managing Project Libraries and Project Servers.”

 — Both the artist workstation and the remote workstation must have access to the same media files 
on either the same storage volumes, or identically named storage volumes.

Using Multiple Project Libraries in Remote Rendering
You can set up remote renders for projects in all connected Davinci Resolve project libraries, 
not just the currently active one. To activate this feature, check the “Automatically scan other 
project libraries for Remote Rendering jobs” box in the General settings of the System tab, of the 
DaVinci Resolve Preferences.

Sharing Storage
It’s important that both the artist and remote workstations have access to the same media on the 
same named storage volume for remote rendering to work properly. This can be done via some 
manner of shared storage, such as a SAN. However, it can also be done by mounting the same volume 
over your network. This will be slower, but it will work. 

If you’re mixing Mac OS X, Windows, and Linux workstations for remote rendering, you’ll need to use 
the Mapped Mount column of the Media Storage Locations list in the Media Storage panel of the 
System Preferences to add each volume’s path as it’s understood on the workstation it’s attached to. 
For example, on a Windows workstation that’s accessing volumes from a Linux workstation, type in 
the Linux-style file paths in the Mapped Mount column for each scratch disk that’s listed.
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Setting Up and Using Remote Rendering
Using remote rendering is easy, but it does require a bit of preparation.

1 Make sure the storage volume containing the media being referenced by the project you want to 
render is mounted on both the artist and remote workstations.

2 Open DaVinci Resolve on the remote workstation, and do one of the following:

 — When the Project Browser opens, right-click anywhere and choose Remote Rendering. 

 — If you’ve already opened a project in DaVinci Resolve, you can also choose Workspace > 
Remote Rendering.

DaVinci Resolve will automatically open to the Deliver page, awaiting jobs to be assigned for 
automatic rendering.

3 On the artist workstation, add a job to the render queue as you normally would. 

4 Click the Remote Rendering button for that job in the Render Queue and one of the options from 
the list that appears:

 — Any: Automatically assigns that job to the next workstation that isn’t currently rendering 
anything. If all remote rendering workstations are rendering, assigns it as the next job in line.

 — YourComputer.local: The artist workstation with the name “YourComputer.” Choose this if 
you want to render the job locally, and not remotely.

 — Other Workstations on Network: All other remote rendering workstations are listed below, 
so you can choose which specific workstation you want to assign a job to.

Clicking the Remote Render 
button to remotely render a job

5 Click Start Render. The job is sent to the remote workstation you selected and is rendered, while 
you’re free to continue working on your artist workstation.

When You’re Finished Remote Rendering
Once you’re done using a particular DaVinci Resolve workstation in Remote Rendering mode and you 
want to go back to using it as an artist workstation, choose Workspace > Remote Rendering to exit 
remote rendering and return to the Project Manager.
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Setting Up a “Headless” 
Remote Rendering Workstation
DaVinci Resolve allows remote rendering clients to operate in a so-called “headless” mode, with no 
GUI. This can be accomplished from the command line, by opening the directory where the app 
is located and then running DaVinci Resolve in Remote Rendering (–rr) mode using the correct 
command line syntax for your operating system. Once run in this way, DaVinci Resolve silently and 
invisibly waits on that system for remote rendering jobs to be sent to that workstation.

On macOS

 — Open Terminal. 

 — Change the directory to:

cd /Applications//DaVinci\ Resolve/DaVinci\ Resolve.app/Contents/MacOS/

 — Run the following command:

./Resolve -rr

On Windows

 — Open the Command Prompt.

 — Change the directory to:

C:\Program Files\Blackmagic Design\DaVinci Resolve\

 — Run the following command:

Resolve.exe -rr

On a Linux CentOS 6.8 system

 — Open Terminal.

 — Change the directory to:

cd /home/resolve/Cyclone/

 — Run the following command:

./script.start -rr

On a Linux CentOS 7.x system

 — Open Terminal.

 — Change the directory to:

cd /opt/resolve/bin

 — Run the following command:

./resolve -rr
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Chapter 188

Delivering 
DCP and IMF
For projects requiring Digital Cinema Package (DCP) or Interoperable 
Master Format (IMF) mastering for digital cinema or broadcast distribution, 
DaVinci Resolve allows native DCP and IMF encoding and decoding for the 
creation and playback of unencrypted DCP and IMF deliverables, or it can 
be integrated with Fraunhofer’s easyDCP application in order to master fully 
encrypted DCP files, play them back for testing, and generate Key Delivery 
Messages (KDMs) for theatrical distribution, all directly within DaVinci Resolve. 

This means you can encode a DCP or IMF master straight from your program’s source media, all 
within the 32-bit floating point image processing pipeline of DaVinci Resolve, for the highest possible 
quality result.

Contents
Native IMF Encoding and Decoding  
(Studio Version Only)  4017

Native Unencrypted DCP Encoding 
and Decoding (Studio Version Only)  4019

Native DCP Encoding Parameters  4019

Rendering IMF Segments 
and DCP Reels  4021

Creating DCP/IMF 
Supplemental Packages  4022

Importing a DCP or IMF Into a Timeline   4022

Editing the Resulting Timeline   4023

Dolby Vision Metadata   4024

Exporting   4024

Photon Validation of IMF Packages  4025

Validating in the Media Pool   4025

Validating on Export   4026

Using and Licensing EasyDCP  4027

Requesting Your Server Certificate Set  4027

Importing Your Server Certificate Set  4027

Switching Between Native DCP 
and EasyDCP Encoding  4028

EasyDCP Color Management  4028

EasyDCP Output in the Deliver Page  4028

KDM Generation and Management  4030

Publishing Your Encrypted 
Digital Cinema Package  4030

Playing Your Digital Cinema Package  4030

Playing Third-Party 
Digital Cinema Packages  4030

4016Deliver | Chapter 188 Delivering DCP and IMF



Native IMF Encoding and Decoding  
(Studio Version Only)
The Format drop-down in the Video panel of the Render Settings now has a native IMF option that 
lets you export to the SMPTE ST.2067 Interoperable Master Format (IMF) for tapeless deliverables to 
networks and distributors. No additional licenses or plugins are required to output to IMF. 

The IMF format supports multiple tracks of video, multiple tracks of audio, and multiple 
subtitle and closed caption tracks, all of which are meant to accommodate multiple output formats 
and languages from a single deliverable. As of DaVinci Resolve 16, IMF export also supports exporting 
IMF packages that use ST.2098 and Dolby immersive audio via selected Main busses. All of this is 
done by wrapping a timeline’s different video and audio tracks (media essences) and subtitle tracks 
(data essences) into a “composition” within the Material eXchange Format (MXF). 

Additionally, a drop-down menu to the right of this preset provides options for Generic, 
20th Century Fox, and Netflix versions of this preset.

The IMF Generic preset in the Render Settings has 
options for different resolutions of output

When IMF is selected from the Format drop-down, the Codec drop-down menu presents 
options for Kakadu or EasyDCP encoding, with Kakadu being the method that’s included with 
DaVinci Resolve Studio. A Type drop-down lets you choose what kind of JPEG2000 output you 
want, with options including RGB, YUV, and Dolby Vision. Additional parameters include:

 — Package Type: Defaults to App2 Extended (App2e), for encoding JPEG 2000 up to 4K.

 — Bit Depth: The bit depth of the encoded IMF video.

 — Encoding Profile: A drop-down that lets you choose among Auto, IMF, and Broadcast.

 — Encoding Level: Provides different choices based on what is selected in Encoding Profile.

 — Maximum bit rate: Lets you choose how much to compress the result.

 — Lossless Compression: Lets you choose to encode using lossless compression.

 — Slope-Rate Control: A checkbox lets you specify lossless compression.

 — QStep: (DCP, IMF) Lets you choose either automatic or manually specified DCP quantization levels 
at which to compress the video signal when using the Kakadu JPEG 2000 encoder. 
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Render settings in the Export Video 
section for the IMF format

A separate group of parameters named Composition Settings, underneath the Advanced Settings, lets 
you add metadata to your IMF package, including:

 — Composition name: The name of the exported composition.

 — Issuer: The organization providing the composition.

 — Use current date: A checkbox that lets the current date be used as the Issue date automatically.

 — Issue date: The date the composition is issued.

 — Content kind: A drop-down provides a list of acceptable choices for defining the content.

 — Content version label: Meant to identify the version of the content being provided.

 — Annotate xml using composition name: Auto-populates Asset Map, Composition Playlist, and 
Packing List with data from the project. Otherwise these three fields are manually editable.

 — Annotate media using filename: Auto-populates Main Video Track and Audio Track 1 with data 
from the project. Otherwise these three fields are manually editable.

Parameters for adding composition metadata
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Native Unencrypted DCP Encoding 
and Decoding (Studio Version Only)
DaVinci Resolve also has native DCP encoding and decoding support built-in, for unencrypted DCP 
files only. That means that you can output and import (for test playback) unencrypted DCP files 
without needing to purchase a license of EasyDCP. If you have a license, a setting in the Configuration 
panel of the System Preferences enables you to choose whether to use EasyDCP (for creating 
encrypted DCP output), or the native DaVinci Resolve encoding.

Native DCP Encoding Parameters
When you choose DCP from the Format drop-down menu, the following additional parameters 
are exposed:

 — HDR: (DCP, IMF) Specifies the package as having HDR content.

 — Use interop packaging: (DCP only, located under Type parameter) Lets you create an Interop 
DCP package, based on an earlier standard of DCP delivery that is not forward compatible with 
SMPTE DCP packages.

 — Maximum bit rate: (DCP, IMF) Lets you choose how much to compress the result.

 — Lossless Compression: (IMF) Lets you choose to encode using lossless compression.

 — Slope-Rate Control: (DCP, IMF) A checkbox lets you specify lossless compression.

 — Quality: (DCP, IMF) Lets you choose either automatic or manually specified DCP quantization 
levels at which to compress the video signal when using the Kakadu JPEG 2000 encoder.

Native DCP settings in DaVinci Resolve

If you’ve selected DCP from the Format drop-down menu, a Composition Settings group appears 
with the following parameters when you click the disclosure control, which let you populate 
standard DCP composition metadata:
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 — Composition name: The name of the exported composition. DCPs use specific naming 
conventions for the composition name that include metadata about the file itself for DCP 
projectors and playback equipment. DaVinci Resolve has a tool called the Composition Name 
Generator to generate these names properly for you; it is accessed by pressing the “Edit” button 
next to this field. Simply fill out the fields and press OK, and DaVinci Resolve will rename your 
composition in line with these standards.

The Composition Name Generator will pass a standards compliant 
name for you to the Composition Name field.

 — Issuer: The organization providing the composition.

 — Use current date: A checkbox that lets the current date be used as the Issue date automatically.

 — Issue date: The date the composition is issued.

 — Content kind: A drop-down provides a list of acceptable choices for defining the content.

 — Content version label: Meant to identify the version of the content being provided.

 — Annotate xml using composition name: Auto-populates Asset Map, Composition Playlist, and 
Packing List with data from the project. Otherwise these three fields are manually editable.

 — Annotate reel index as suffix: Auto-populates Reel Annotation with data from the project. 
Otherwise this is manually editable.

 — Annotate media using filename: Auto-populates Main Video Track and Audio Track 1 with data 
from the project. Otherwise these three fields are manually editable.
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Parameters for adding composition metadata

Rendering IMF Segments 
and DCP Reels
DaVinci Resolve supports splitting IMF and DCP projects into separate segments and reels, in addition 
to rendering media as a single file. This can be useful for breaking up your timeline to fit within 
allowed file sizes on legacy file systems, separating marketing and studio assets from the final film, or 
just being able to replace certain sections of the film without having to re-encode the entire file.

To Render an IMF Segment or DCP Reel:

1 Choose IMF or DCP from the format settings in the Video tab of the Render Settings panel.

2 Navigate to the “Segment list” or “Reel list” section of the composition settings. 

3 Choose from the following options:

 — Single segment/reel: Encodes the Timeline into a single file (default setting).

 — Regular intervals of: Encodes the Timeline into multiple segments/reels, each one the 
duration of the value set in the “mins” field.

 — Align to clips on the first video track: Encodes the Timeline into multiple segments/reels; 
each individual clip on the V1 track of the Timeline becomes its own separate file.

 — Keep audio as single segment (IMF only): Select this checkbox to keep the audio portion of 
the IMF as a single file, regardless of the segment options selected above.

4 Press the Add to Render Queue button. 

IMF Segment options
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Creating DCP/IMF 
Supplemental Packages
Once created, DaVinci Resolve has the ability to reimport a DCP or IMF so that you can overwrite 
parts that need to be updated with new media, in order to export a “Supplemental Package,” which is 
effectively a new version of the program that combines the new overwritten parts of the program with 
the old version, such that you can deliver just the changes.

NOTE: Supplemental packages are only supported using the Kakadu encoder and decoder; 
this is not compatible with DCP or IMF packages created using EasyDCP. To avoid issues, 
disable “Use easyDCP decoder” in the Decode Options panel of the DaVinci Resolve 
System Preferences.

Importing a DCP or IMF Into a Timeline 
1 Using the Media Storage browser in the Media page, find and select the DCP or IMF, and check 

the header of the Metadata Editor to verify that your media is suitable for creating a supplemental 
package. Supported IMF profiles will be displayed in the Metadata Viewer.

 

The header in the Metadata Editor showing an IMF that’s 
compatible with the creation of a supplemental package

2 Create a new project and add the DCP/IMF package you need to modify to the Media Pool. If 
a dialog appears asking if you want to change your timeline frame rate to match the incoming 
media, click Change to make your project match the media. 

3 Create a timeline from the composition playlist (XML) within the imported DCP or IMF by right 
clicking the imported package in the media pool and choosing “Create New Timeline Using 
Composition Playlist” from the contextual menu.

Right-clicking an imported IMF or DCP clip in the Media 
Pool reveals a command to make a new timeline using 
the composition playlist in the contextual menu

4 The New Timeline dialog has an “Import Dolby Vision Project Settings” checkbox. When it’s turned 
on, clicking Create will do the following:
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a) Dolby Vision will be enabled in the Color Management panel of the Project Settings, and the 
Mastering Display menu will be set to match that of the IMF package.

b) If Resolve Color Management (RCM) is not active, the Timeline Color Space will be set to 
match the Dolby Vision metadata. However, if RCM is already enabled, the user must manually 
set this by turning on “Use Separate Color Space and Gamma,” and changing the Timeline 
settings to P3-D65” and “ST.2084” respectively.

5 Creating the Timeline will import Dolby Vision metadata (if applicable). This will allow a 
Tone Mapping preview to be seen on the Color page that uses the original metadata. 

Dolby Vision metadata will be imported 
if present when importing an IMF

Once import is complete, all video and audio clips from the DCP or IMF appear within a new bin with 
the name of the package. The resulting timeline will be identified via its icon as a DCP/IMF timeline. 

 

The imported media and timeline when you import an IMF

Editing the Resulting Timeline 
At this point, you can edit the program in the Timeline as necessary. 

 — You can overwrite sections of the Timeline with new clips. All modifications will be automatically 
included into the supplemental package.

 — You can use the Blade tool or Insert Edit command to cut sections of the existing program to 
which you want to add Fusion effects, audio grading, or color correction. When you do this, 
you must right click that section and choose “Include in Supplemental Package” to make sure it 
exports correctly.

 

Right-clicking a section of the program and 
choosing Include In Supplemental Package

For IMF Dolby Vision packages, please ensure all modifications are on the first video track (V1).
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NOTE: If RCM is being used, please ensure the input color space and gamma of the inserts 
are correct.

Dolby Vision Metadata 
The Dolby Vision metadata from the imported DCP/IMF file can be reused by selecting 
“Original Metadata” from the Tone Map Using drop-down menu of the Dolby Vision palette 
in the Color Page 

 

Setting a clip to Original Metadata in the Color Page

Alternatively, this metadata can be imported separately from an existing XML via the “Import 
Metadata from XML” command in the option menu of the Dolby Vision palette in the Color page. 
When successful, “Imported Metadata” will be enabled.

Exporting 
You can export a supplemental package by turning on “Supplemental Package” in the the video panel 
of the Deliver page Render Settings list.

 

Setting an export to be a Supplemental Package
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The codec type and profile will be automatically selected to match the original version of the DCP/IMF 
package, and the audio tracks are set to match the Timeline tracks. Please ensure the rest of these 
audio settings are matched to the original version, since they start out set to the default values. 

Setting the audio settings of a 
Supplemental Package export

Photon Validation of IMF Packages
Photon is Netflix’s validation software for IMF App2/App2e packages. The option for using Photon 
validation will only be shown on Resolve Studio with JDK/JRE version 1.8 and above installed, which is 
available at https://github.com/Netflix/photon.

NOTE: Please disable “Use easyDCP decoder” from “Preference” as there can be issues 
decoding IMF packages without an easyDCP license. 

Validating in the Media Pool 
An existing IMF package can be validated with Photon by importing it into the Media Pool, then right-
clicking it and choosing “Perform Photon Validation” from the context menu.

Validating an IMF in the Media Pool
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A report dialog will be shown when the validation is completed.

A validation report

Validating on Export 
Photon validation can be enabled in the File panel of the Deliver page Render Settings; choosing the 
“IMF Netflix” preset will also enable this option. When enabled, DaVinci Resolve will perform Photon 
validation after the IMF package is exported. The validation report will be saved to a text file in the IMF 
package folder, and a report dialog will be shown if there is any error. 

Enabling Photon validation on export
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Using and Licensing EasyDCP
Both DaVinci Resolve and DaVinci Resolve Studio include a demo version of easyDCP. Details of 
operation and restrictions of the demo version can be found later in this chapter. The fully functional 
version of easyDCP operates via licensing modules purchased from http://www.easyDCP.com (info@
easyDCP.com) and every new DaVinci Resolve system (server) needs its own license and specific 
certificates for DCP and KDM generation and for playback of DCPs. 

Requesting Your Server Certificate Set
For your DaVinci Resolve system to generate DCPs and KDMs you need to request a specific set of 
configuration files called the Server Certificate Set. To begin, first purchase your encoding, encryption, 
decoding, and decryption modules from easyDCP. They will provide a password to access your 
easyDCP account.

Then, from the DaVinci Resolve File menu, select easyDCP > Request Server Certificate Set. Fill in the 
detail listed on the request form and save the form to your desktop or somewhere it can be easily 
found. This html file can be emailed to info@easyDCP.com. After sending the html, a customized 
Server Certificate Set for your installation will be generated and made available for download in your 
easyDCP Website User Account. 

The Server Certificate Set generated for your DaVinci Resolve will contain files based on your 
purchased modules and your specific DaVinci Resolve server hardware. The table below shows the 
modules and the licenses and certificates generated, followed by a brief description of each item.

License Server Certificate Signer Certificate

DCP Encoder X  X

DCP Encoder with Encryption X X X

DCP Player X

DCP Player with Encryption X X

 — License: The License is used to activate the purchased modules on a specific hardware server. 

 — Server Certificate: Each DCP render (referred in the industry as an “Instance”) using encryption 
or decryption has an individual server certificate. This certificate is required to be able to receive 
Key Delivery Messages (KDMs), which unlock encrypted DCPs.

 — Signer Certificate: A Signer Certificate is used to sign certain files within a DCP package and/or 
Key Delivery Message (KDM) to verify which authority generated the DCP instance.

Importing Your Server Certificate Set
Once generated and downloaded to your DaVinci Resolve server, the Server Certificate Set needs to 
be imported into DaVinci Resolve. 

To import your server certificate:

1 Choose File > easyDCP > Import License and Certificates. 
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2 Use the Import Server Certificate dialog to select the file, enter your Certificate Set password, 
then click Import.

3 To verify your easyDCP license and the Server Certificates, choose easyDCP > About easyDCP.

From this point onward, you can use the controls from within the Settings window, the Deliver page, 
and the File menu to master and play DCPs.

Limitations of the Demo Version of easyDCP
The demo version of the DCP encoder embeds visible DaVinci Resolve and easyDCP logo 
watermarks in the rendered Digital Cinema Package (DCP) images. The demo version 
does not include encryption so these DCPs can be used for screening in a digital equipped 
cinema. The demo version of the DCP playback module will play 15 seconds in full quality. 
After that playback quality reduces drastically. Furthermore, audio won’t be rendered after 
15 seconds of playback.

Switching Between Native DCP 
and EasyDCP Encoding
A checkbox in the Configuration panel of the System Preferences, “Use EasyDCP Encoder,” lets you 
choose whether to use the native DCP/IMF encoding in DaVinci Resolve, or your licensed EasyDCP 
software. In either case, all set up happens from within the Deliver page of DaVinci Resolve.

EasyDCP Color Management
The Color Management panel of the Project Settings has a Timeline Colorspace drop-down menu that 
is enabled for EasyDCP encoding regardless of whether or not DaVinci Resolve Color Management is 
used for the current project (the same setting is used for both color management tasks). You should 
set this to the color space used by your current DaVinci Resolve timeline. If, for example, you are 
grading using a Rec. 709 monitor for television deliverables but also wish to make a DCP, select Rec. 
709 Gamma 2.4 and DaVinci Resolve will render the DCP with the correct Rec. 709 to XYZ matrix. 

EasyDCP Output in the Deliver Page
To master to a DCP in the Deliver page, use the following procedure, which walks you through all of 
the easyDCP settings that are available in the Render Settings list.
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To master a DCP or IMF:

1 Set “Render timeline as” to Single clip.

2 Choose easyDCP from the Video Format drop-down.

3 Choose the appropriate option from the Codec drop-down that corresponds to the type (DCP or 
IMF) resolution (2K or 4K), and aspect ratio (native, scope, or flat) of your intended output.

4 Set the Composition Name. This field is intended to hold a standardized name for the DCP being 
encoded. You can either type a name into this field directly, or you can press the “...” button to 
open the easyDCP Composition Name Generator window. An editable Film Title field appears, 
along with a number of drop-down menus that let you select various DCP attributes such as 
content type, aspect ratio, language of audio and subtitles, and so forth. As you populate each 
attribute, the name being generated appears at the top of the window, and clicking OK copies the 
resulting Composition Name into the Composition Name field of the Render Settings.

5 If necessary, set the desired “Maximum DCP bit rate” by either typing or dragging within the field 
(the range is 50 to 250 Mbit/sec). If you’re not sure what data rate to use, consult the client or 
distributor to whom you’re delivering the DCP.

6 There are two DCP package types you can output, determined by the “Use Interop 
packaging” checkbox:

 — The standard package conforms to the “Interop” specifications for DCPs, which is turned on by 
default. With “Use Interop packaging” turned on, however, the frame rate of your output is limited to 
either 24fps or 48fps, so you need to make sure that your timeline conforms to these frame rates.

 — If you want to generate DCP packages with other frame rates to match your timeline, you 
need to turn “Use Interop packaging” off to generate a SMPTE-standard DCP. This supports 
additional frame rates including 25, 30, 50, and 60 fps. However, SMPTE-Standard-DCPs are 
not supported on all JPEG2000-based playback systems so it’s generally recommended to use 
the Interop standard unless you know the player supports the SMPTE-Standard DCPs.

7 Turn on the “Encrypt package” checkbox to encode an encrypted DCP. This sets the encoder to 
generate a Digest containing the keys used during encryption. This Digest will allow you to play the 
resulting DCP on your system, and to generate KDMs to allow that DCP to be played on other servers.

NOTE: If you do not encrypt the DCP it can be played on any DCP player/decoder 
without restriction.

8 Set the Subtitles Path. If you have a properly formatted subtitle file, click the Browse button to link to it.

9 If you’re including an audio mix in the DCP, go to the Audio section, turn on the Render audio 
checkbox, and choose the number of channels in the “Render channels of audio” drop-down 
menu that corresponds to the number of Audio Mixer output channels defined in the Edit page.

10 Click the Browse button under the “Render to” field, and choose a location for the resulting DCP. 
Make sure you pick a drive with enough room for the estimated size of the final DCP.

11 Choose all necessary options from the Output Options to ensure the quality you need.

12 Click the Add Job to Render Queue button, and then click Start Render to create your DCP. 
A DCP will be created and placed at the location you chose, ready for playback or delivery.
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KDM Generation and Management
Key Delivery Messages (KDMs) are required to allow an encrypted DCP play on a designated projector at 
a particular theater at a specified time. DaVinci Resolve is capable of creating KDMs, which is convenient 
for exporting KDMs for select screenings, but commercial distributors may require thousands of 
KDMs. Fortunately, easyDCP allows you to use external Distribution KDM (DKDM) utilities to generate 
KDMs for your clients, so you don’t have to tie up your DaVinci Resolve workstation with this task. 

Publishing Your Encrypted Digital Cinema Package
While you can play your encrypted DCP on the same DaVinci Resolve system that generated it, if you 
wish to publish the DCP so other players can decode and play you need to generate a KDM to send to 
the player. The user of the other player, or players, will need to generate a Server Certificate for each 
of their players and send this to you so when you generate the KDM it will be just for those players.

Select the DCP in the Media page Library. Right-click and select Generate KDMs. From the drop-down 
select the location of the Server Certificate file if the KDM is for one player, or folder for multiple 
players. Set the start and end dates that the KDM will be valid for, an output folder to place the KDM, 
and then select Generate.

You can now send your DCP and the KDMs to the player you authorized. The user there will import the 
KDM and the DCP will play between the start and end dates.

Playing Your Digital Cinema Package
To play a DCP you’ve output from DaVinci Resolve, use the Media page to add it to the Media Pool and 
edit it into a timeline like any other clip.

Decoding the JPEG2000 images embedded within the DCP in real time is computationally intensive. 
If your system is underpowered you can reduce the decoded resolution of the files by selecting Half 
or Quarter Resolution Decode from the File > easyDCP menu. A smaller, less bandwidth-intensive 
version of the JPEG2000 files will be decoded by discarding some levels of the wavelet stage inside the 
decoder, which will directly increase the playback performance. 

Playing Third-Party Digital Cinema Packages
To play a non-encrypted DCP simply select the DCP in the Media page like any other clip. To play 
an encrypted DCP from a third party you first must publish your Server Certificate. They use the 
certificate to generate KDMs for their DCP to play on your DaVinci Resolve system. From the File menu 
choose easyDCP > Export Server Certificate, and on the drop-down menu choose a location to save 
the file. Send this to the third party for KDM generation.

When you receive a KDM or a Digest for an encrypted DCP you must first import the file into your 
DaVinci Resolve system. Choose File > easyDCP menu > Import KDM/Digest, and then select the file. 
Then simply select the encrypted DCP in the Media Page Library to play.

4030Deliver | Chapter 188 Delivering DCP and IMF



Chapter 189

Delivering to Tape
This section covers how to use the Deliver page to output a 
timeline, either in whole or in part, to a device-controllable 
VTR connected to a compatible Blackmagic Design video interface. 

For whichever output interface you use, you need to make sure that the RS-422 interface is connected 
to that of the VTR, and that device control has been established.
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The Tape Output Interface
Tape output is accomplished on the Deliver page, which has to be placed in the Tape mode before you 
can proceed.

To switch to tape output in the Deliver page:

 — Click the Tape button, which is the third button from the left on the Interface toolbar at the top of 
DaVinci Resolve. The Deliver page updates to reflect the relevant controls for editing to tape.

While in Edit to Tape mode, the Deliver page is used to control the VTR, in order to establish In and 
Out points for insert or assemble editing of the selected portion of the current Timeline to tape.

 — Capture and Playout: The Render Settings panel turns into the Capture and Playout panel, with 
controls and settings governing how DaVinci Resolve will output your program to tape.

 — Edit to Tape Queue: The Render Queue turns into the Edit to Tape Queue, which lets you set up 
a batch of either previously rendered media files, or In and Out point-defined segments of the 
current Timeline for simultaneous output to tape.

 — Transport controls: The transport controls, while similar in appearance to those used while in 
Render mode, now control the VTR. While in Edit to Tape mode, the transport controls of the 
DaVinci control panel also control the deck, rather than your program.

 — Shuttle control: A shuttle control appears in what was formerly the jog or scrubber bar, which 
lets you shuttle through the range of reverse and forward speeds compatible with that deck.

 — In and Out controls: In Edit to Tape mode, the In and Out buttons to the right of the transport 
controls define a range of the tape to Insert or Assemble edit to, within the current Timeline. 
While in Edit to Tape mode, you can still define In and Out points to define a specific range of the 
Timeline by right-clicking a clip in the Thumbnail or Mini-Timeline, and choosing Mark In or Mark 
Out. You can only add In or Out points to the beginning and end of clips. 

 — Cue In and Cue Out controls: Buttons next to the timecode In and Out fields cue the tape to 
those frames on tape.

Edit to Tape controls

Gang Timecode to Tape
When the Deliver page is in Tape mode, you can right-click the ruler running along the top of the 
Timeline and choose “Gang Timecode to Tape,” which puts DaVinci Resolve into a mode where every 
time you set an In point on the Deliver page Timeline, a corresponding In point is automatically set on 
the tape deck. Setting both In and Out points on the Deliver page Timeline results in the In and Out 
points on the tape deck being set at the same timecode, making it easy to set up insert edits to tape 
on top of a previously output program.
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The Gang Timecode to Tape option

Insert/Assemble Drop-down Menu
A drop-down menu under the In and Out buttons lets you choose how to edit the selected part of the 
Timeline to tape. There are two options:

 — Insert: Performs an insert edit to tape, in which selected tape tracks are seamlessly and frame-
accurately overwritten without interrupting the timecode or control track. You must be outputting 
to either a blacked tape, or a prerecorded tape to make an insert edit.

 — Assemble: Performs an assemble edit, in which every track of tape is overwritten, including the 
video, audio, timecode, and control tracks. 

 — Crash: (Only appears if “Output Source Timecode” has been enabled in the Playout section of the 
Capture and Playback panel of the Project Settings) Similar to an assemble edit, except there is no 
pre-roll period to let the VTR get up to speed. A crash edit also overwrites every track of the tape, 
including the video, audio, timecode, and control tracks, and may result in a more visible jump 
at the resulting edit point. However, in some instances crash edits may be the only option for a 
particular operation.

NOTE: When DaVinci Resolve is performing a Batch Output operation, you can only output 
clips using assemble editing or crash recording.

Start Record Button
Once you’ve set In and Out points to define how much of the tape to record to, the Start Record 
button initiates device-controlled tape output.

Setting Up for Tape Output
Before you perform an edit to tape, the Capture and Playback panel of the Project Settings has a 
number of options that you should set to match the format and type of tape output you’re doing.

General Options
The Output LTC checkbox, when turned on, directs DaVinci Resolve to output LTC timecode.
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Capture and Playout Settings
These settings affect both capture and playback when using the Tape Ingest options of the Media 
page, or the Tape Output options of the Deliver page.

 — Video capture and playback: You can choose the video format (frame size and frame rate) with 
which to output to tape from this drop-down menu. HD timelines can be downconverted to SD, 
and SD timelines can be upconverted to HD using the format conversion of your DeckLink card.

 — Use left and right eye SDI: A checkbox that enables supported video interfaces to ingest and 
output muxed stereoscopic video when used with supported VTRs, such as HDCAM SR decks 
with 4:2:2 x 2 mode. (When muxed stereoscopic signals are ingested, each eye is separated into 
individual left-eye and right-eye image files.) This parameter only appears when your hardware is 
set up appropriately.

 — Video connection operates as: Selects between the available signal options: Use 4:4:4 SDI, and 
enable Single Link. Which options are available depend on which video capture card you are using.

 — Data Levels: Lets you specify the data range (normally scaled or full range) that’s used when 
ingesting from or outputting to tape. This option switches the data range of the signal output by 
your video capture card, but only during capture from tape in the Media page, or output to tape in 
the Deliver page. When capture or output is not currently occurring, your video capture card goes 
back to using the identically named data range setting in the Master Settings panel of the Project 
Settings, which governs how you monitor the signal being output on an external broadcast 
display or projector.

 — Video bit depth: Choose the bit depth that corresponds to the capability of your deck. You can 
choose between 8-bit and 10-bit. Outputting to 10-bit is more processor intensive, but higher 
quality for compatible devices, and is the default setting.

 — Use deck autoedit: If supported by your video deck, this is the best method to record video to the 
deck, as it enables the deck to roll the edit using the specified preroll, and control the edits via serial 
device control. If this checkbox is turned off, a basic edit On/Off mode is used by the deck, with the 
potential for frame inaccuracies if the “Non auto edit timing” setting is not properly adjusted.

 — Non auto edit timing: Adjusts the edit synchronization of the connected deck when auto edit is 
turned off.

 — Deck preroll: Sets the number of seconds for preroll. How much is appropriate depends on the 
performance of your deck.

 — Video output sync source: When using a DeckLink card this is set to Auto. Other capture 
cards may require you to set the sync source to “Reference” for playout and “Input” for ingest. 
This setting is only available if you have a DVS card installed on your system.

 — Add 3:2 pulldown: Inserts or removes the 3:2 pulldown required to record or play 23.98 fps 
media to or from a 29.97 tape format.

Capture
These settings are used when you use the Capture mode in the Media page to capture clips from tape 
into the Media Pool. Media is captured as DPX image sequences.

 — Capture: Lets you choose whether to capture both Video and Audio, or Video Only.
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 — Video Format: The format that scanned film frames are saved as.  When capturing from tape, 
the available options are DPX and QuickTime. When capturing from the Cintel film scanner, this is 
restricted to Cintel Raw Image (CRI), which is a raw data format that DaVinci Resolve automatically 
debayers as a Cineon log-encoded image for grading.

 — Codec: The codec used to write captured media. When capturing from tape, these include the 
various type of Apple ProRes, 8- and 10-bit YUV 422, 10-bit RGB, and the various types of DNxHD. 
Cintel Raw Image files default to RGB.

 — Save clips to: A field that displays the directory path to which media files captured from tape are 
written. You want to choose a volume that’s fast enough to accommodate the data rate of the 
media format you’re capturing.

 — Browse: Click this button to choose a directory to write captured media to. The directory you 
choose appears in the field above.

 — Save in this folder path: A series of checkboxes let you specify what other information to use to 
define the directory hierarchy that will hold the captured media. Every checkbox you turn on adds 
an additional directory with a name defined by that checkbox’s metadata. You can choose any or 
all of the following: Program name, Clip number, Reel number, and Roll/Card.

 — Apply reel number to: Lets you choose how to write the reel name. Two checkboxes let you write 
the reel number to the file’s name, and/or to the Header data.

 — Use prefix: A field lets you type in a prefix to be used in the media file’s name. This lets you add 
text identification that will make the media more easily identifiable and searchable.

 — Apply prefix to: Two checkboxes let you choose to use the prefix you typed in the file name, 
and/or in the folder name.

 — Use frame number with: When capturing to image sequences, you can choose how many digits 
to use when writing the frame number into the name of each frame file.

 — Set batch ingest handles to: When capturing to image sequences from a batch list, defines how 
many frames of additional handles to ingest along with each logged clip.

 — Enable audio input: Turn this checkbox on to capture audio along with the video. If you’re 
capturing QuickTime or MXF files, the audio will be written as additional tracks inside each file. 
If you’re capturing to a DPX image sequence, then a broadcast .wav file is recorded separately.

 — Input: Lets you choose how many tracks of audio to capture, from 2 to 16.

Playout Settings
These settings only affect the video signal that’s output when you use the Edit to Tape mode of the 
Deliver page.

 — Output: Lets you choose whether to output both Video and Audio, Video Only, or Audio Only if 
you’re doing an audio layback.

 — Output Source Timecode: Turn this checkbox on to output each individual clip’s source timecode. 
This option is only applicable when assemble editing to tape.

 — Output LTC: With a Blackmagic Design DeckLink or UltraStudio device using HD-SDI, longitudinal 
timecode (LTC) is available on track 16 of the HD-SDI video signal, making it easy to use a Mini 
Converter de-embedder to extract this analog timecode audio signal and feed it directly to a 
recording device. This is particularly helpful if you have outboard video processing equipment 
such as a noise reducer or format converter that does not pass through the VITC timecode.
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 — Delay LTC by x frames: When outputting LTC to bypass outboard processing gear, such as a 
noise reducer or format converter, you can compensate for the processing delay by delaying the 
timecode by a matter of frames to ensure that the processed image and timecode reach the deck 
at the same time. With a DVS card there is a separate timecode output.

 — Enable audio output: When this checkbox is enabled, DaVinci Resolve will play all available 
timeline audio along with the video being output, so both can be recorded to tape.

 — Offset audio by x frames: Lets you specify an offset between the audio track and video to achieve 
proper A/V sync in cases where the video is being delayed by outboard processing hardware.

 — Output x channels of audio: Choose the number of audio tracks to output to tape.

 — Set batch playout head handle to x seconds: When batch outputting multiple clips, you can 
specify a number of frames before the In point of each clip to be output as well.

 — Set batch playout tail handle to x seconds: When batch outputting multiple clips, you can 
specify a number of frames after the Out point of each clip to be output as well.

 — Apply gaps between clips: This checkbox lets you add a black gap, of the specified duration in 
frames, between every two clips being output when outputting in batch mode.

Edit to Tape Queue Option 
Menu Settings
The following settings and options are available in the Option menu found at the top right-hand 
corner of the Edit to Tape Queue.

 — Show Job Details: Lets you see more information about each job listed in the Render Queue.

 — Clear Recorded: Clears all queue items that have already been output to tape.

 — Clear All: Clears every queue item.

 — Sort by Reel & Timecode: Does a multi-criteria sort by reel and timecode, reel first, then timecode.

 — Sort by Timecode: Sorts by timecode only.

 — Output Source Timecode: Sets tape output to write source timecode to tape (each clip’s 
individual timecode), rather than record timecode (from the Timeline).

 — Use Preview for Tape Output: Enables Preview mode when outputting to tape. Preview mode 
lets you test how an edit to tape operation will work before actually recording it.

Tape Output Procedures
There are a few different ways you can output media to tape, depending on what you need to accomplish, 
and on how intensive your grades are relative to the processing capabilities of your workstation.

Power Mastering
Power Mastering allows you to select either a range of clips, or an entire timeline, to be output to tape 
in real time, without rendering. This can save you from a time-consuming render, and it also saves disk 
space. Power Mastering is a no-compromise procedure, since your program is still output at full quality.
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If there are a handful of clips with grades that you know are too processor-intensive to be Power 
Mastered, you can use the Render Cache controls to cache the problem clips before output. For more 
information, see Chapter 8, “Improving Performance, Proxies, and the Render Cache.”

Outputting a Program From the Timeline
The simplest method of outputting to tape is to output a single Timeline, either in its entirety, or in 
part if you’re insert editing a small section that has been revised.

To Power Master to tape:

1 Use the Render Cache, if necessary, to cache any clips that are too processor-intensive to output 
in real time.

2 Click the Edit to Tape mode button to the left of the transport controls to switch to tape output.

3 Define how much of the current Timeline to output by moving the playhead throughout the 
program, and then right-clicking clips that define the beginning and end of the range you need to 
output and using the Mark In and Mark Out commands.

4 Use the transport controls to find the In point on tape at which you want to start recording, and 
click the In button.

5 Choose Insert from the drop-down menu at the upper right-hand side of the Viewer, if you’re 
either outputting to a striped and blacked tape, or inserting over an existing program on tape.

6 Click the Power Mastering (lightning bolt) button at the bottom of the tape settings to add the job 
you’ve just set up to the Edit to Tape Queue.

7 Click Start Record to begin the process of outputting to tape. Device control is used to record to 
the designated section of tape; a progress bar appears at the bottom of the Render Queue to 
show how long this will take.

If you don’t want to Power Master, you can render the section of the Timeline you need to output as a 
single clip first, as a self-contained media file, and then add that clip directly to the Edit to Tape Queue. 
This might be an easier solution if you’re outputting an extremely processor-intensive timeline.

To output a pre-rendered media file to tape:

1 Click the Add Clips button at the bottom of the tape settings, and use the VTR Record dialog to 
select the media file you rendered in step 1, and click Add Clip(s) to Queue.

The media file you selected is added to the Edit to Tape Queue as a Power Mastering job, and will 
be output in its entirety.

2 Use the transport controls to find the In point on the tape at which you want to start recording, 
and click the In button.

3 Choose Insert from the drop-down menu at the upper right-hand side of the Viewer, if you’re 
either outputting to a striped and blacked tape, or inserting over an existing program on tape.

4 To preview what the edit will look like before actually writing it to tape, choose “Use Preview for 
Tape Output” from the Edit to Tape queue option-menu, and then click Start Record to watch 
DaVinci Resolve run through the edit using the deck. After previewing the edit, turn this setting off.

5 Click Start Record to begin the process of outputting to tape. Device control is used to record to 
the designated section of tape; a progress bar appears at the bottom of the Render Queue to 
show how long this will take.
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Batch Outputting Multiple Clips
You also have the option of outputting a number of clips to tape in a batch operation, as opposed to 
outputting from the Timeline. When you set up a batch of multiple clips in the Edit to Tape Queue, 
then DaVinci Resolve will automatically record them sequentially to tape. 

How the timecode is generated during batch output depends on the “Output Source Timecode” 
setting in the Capture and Playback panel of the Project Settings. If this is turned off, then a 
continuous timecode track will be written to cover everything being output to tape. If this is turned on, 
then each clip’s source timecode will be written to tape discontinuously.

When batch outputting to tape, you can add black handles to each of the clips to space them out, 
making later ingest easier, using the “Set batch playout head/tail handle” settings in the Capture and 
Playback panel of the Project Settings.

To make a Batch Record multiple clips to tape:

1 Use the transport controls to find the In point on tape at which you want to start recording, and 
click the In button.

2 Do one of the following to add items to output to the Edit to Tape Queue:

 — Click the Add Clips button at the bottom of the tape settings, and choose one or more media 
files from the VTR Record browser, and click Add Clip(s) to Queue.

 — Right-click any clip in the Timeline, choose Render This Clip, and then click the Power 
Mastering button at the bottom of the tape settings to add that clip to the Queue.

3 Choose either Assemble or Crash from the drop-down menu at the upper right-hand side of the 
Viewer. Because you’re outputting clips with discontinuous timecode, you cannot insert edit when 
batch outputting.

4 Once you’ve added all the clips you want to output to the queue, click Start Record to begin 
outputting to tape. Device control is used to record to the designated section of tape; a progress 
bar appears at the bottom of the Render Queue to show how long this will take.
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Chapter 190

Exporting Timelines 
to Other Applications
Once you’ve completed editing and grading a program, you may 
need to export your final graded timeline as EDL, AAF, XML, or 
OTIO files in order to send it to another application for further 
finishing, effects work, or to complete a round trip from an NLE.

To send a graded project to another application, you need to render the graded clips first using 
the controls on the Deliver page to render the Timeline as individual source clips. In this mode, the 
reel name and timecode metadata of each rendered clip is mirrored by the exported project file, to 
maintain the correlation between exported EDL, XML, AAF, or OTIO data and the rendered media. 
For detailed information about rendering in the Deliver page, see Chapter 187, “Rendering Media.”

If you render using the Easy Setups that correspond to Final Cut Pro XML or Avid AAF round trips, 
then an XML or AAF will be exported to the same directory you’ve rendered to. However, you can still 
export an XML, AAF, or EDL file separately should the need arise.

Alternately, if you’ve edited a project from scratch in DaVinci Resolve and need to move a timeline 
to another application, you can export any timeline to any format for purposes of project exchange, 
without the need to render new media (depending on your workflow). 

Even in situations where you’ve imported a timeline from another application, the robust project 
compatibility of DaVinci Resolve makes it possible to import one type of project exchange file, 
such as XML, and then export a completely different kind, such as AAF or EDL. This lets you use 
DaVinci Resolve as a project exchange utility.
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Exporting Timelines from 
DaVinci Resolve
Modern post-production is not a one-stop process. It’s a common need for timelines and assets to be 
moved between many different applications from a multitude of companies. While DaVinci Resolve has 
its own proprietary .drt format for use in passing timelines between DaVinici Resolve workstations, 
the program also offers a robust toolset for moving your assets to many other popular applications.

As of this writing, the most reliable way to pass DaVinci Resolve timelines between 
applications is as follows:

 — From DaVinci Resolve to/from another DaVinci Resolve workstation: Export/Import a 
DaVinci Resolve Timeline file (.drt)

 — From DaVinci Resolve to/from another application: Export/Import an OpenTimelineIO file 
(.otio, .otioz), if supported. If not supported, fall back to using XML or AAF flies instead.

Exporting to OTIO
DaVinci Resolve supports the Open Timeline IO (.otio) format for importing and exporting timelines 
between applications. OTIO is an open source media and timeline interchange format created by the 
Academy Software Foundation. It’s designed to be application and platform agnostic, allowing you to 
pass your timeline and its media assets between programs with more compatibility than AAF or XML.

There are two different OTIO formats supported by DaVinci Resolve:

 — .otio: These files contain just the metadata about the timeline and no associated media. They are 
small, portable, and require the end user to link the timeline to their own copies of the media.

 — .otioz: These bundle files contain both the timeline metadata and all of the timeline’s media 
assets zipped together into one file. As a result, this file can be very large, as it contains the full 
length media files of all assets used in the timeline. However it assures that whoever imports the 
file has all the media needed and is linked automatically to replicate the timeline on their machine 
without error.

To Export an OpenTimelineIO (.otio, .otioz) file:

1 Select File > Export > Timeline (Shift-Command-O).

2 Type in a name for the timeline file.

3 In the file browser select either .otio files or .otioz bundle files in the format selector.

4 Click Save.

NOTE: If you selected to export .otioz bundle files, an additional step of creating the OTIO 
bundle will occur as it adds each complete media file from all clips in the timeline to the final 
bundled file. This can take a long time and may need additional storage based on the length 
and amount of media assets used.
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Exporting to AAF/XML
Whether you’ve edited your project from scratch inside of DaVinci Resolve, or you’re doing a round trip 
with an application that uses AAF, Final Cut Pro 7 XML, or Final Cut X XML project exchange formats, 
you can export any DaVinci Resolve timeline in the Edit page to any project format DaVinci Resolve 
supports. Whatever your workflow, keep the following in mind:

 — Timelines are automatically exported when you render a timeline in the Deliver page: When 
you use the “Final Cut Pro Round-Trip” or “Avid AAF Round-Trip” render setting presets, or a preset 
created from one of them, a corresponding XML or AAF file is automatically exported along with 
the media you render. 

 — Even if you’ve imported a project from another application, you can re-edit imported 
projects before export: If necessary, you can freely re-edit projects you’re planning to export. 
When you export an AAF or XML file, the Timeline will be sent back to the originating NLE, or 
onward to the finishing application of choice.

 — Unsupported effects are sometimes preserved in Round Trip workflows: If there were 
effects or clip constructs in the original sequence that were not compatible with DaVinci Resolve, 
how those effects will be handled depends on the project format you’re exporting to, and 
whether or not you’ve edited the project. For XML projects, unsupported effects are saved 
internally by DaVinci Resolve, and are exported with the XML file that you output no matter what. 
Consequently, they should reappear when you reopen the exported file in the originating NLE. 
For AAF projects, you can export unsupported effects as long as you don’t re-edit the project. 
However, if you do re-edit the project, then you can only export an AAF file that’s been stripped of 
all unsupported effects.

 — Project formats can be converted to other formats: Using DaVinci’s Export commands, 
compatible project formats can be converted from one format to another. For example, an 
imported EDL can be output as Final Cut Pro X XML. For that matter, Final Cut Pro 7 XML can 
be imported and then exported as Final Cut X XML. Or, an AAF file from Media Composer can 
be imported and then exported as a Final Cut Pro XML file to be opened in any NLE or finishing 
application compatible with that format, such as Premiere Pro or Smoke.

To export an AAF or XML file after you’ve rendered the graded clips:

Do one of the following:

1 To export the current Timeline, choose File > Export AAF, XML, or press Shift-Command-O.

 — Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose 
Timelines > Export > AAF/XML.

 — When the Export XML dialog appears, type a name for the file and choose a location for the 
exported XML file, then click Save.

2 An XML version of that timeline is saved, complete with references to the graded media you 
rendered, and is ready for import into an NLE or finishing application.
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More About Exporting to AAF
When you export to AAF, there are actually two options that are available to you, depending on 
whether you made editorial changes to the Timeline in the Edit page:

 — If you didn’t make any editing changes to the Timeline you imported: You can choose 
File > Export AAF, XML, and choose “AAF Files” from the Format drop-down menu. This exports all 
audio and effects using data from the original AAF file that was exported from Media Composer, 
regardless of whether or not they’re supported in DaVinci Resolve. When you export an unedited 
AAF, DaVinci Resolve uses the Avid AAF file that you originally imported to create an updated one; 
make sure it’s still in the same location as it was when you first imported it into DaVinci Resolve.

 — If you made editing changes to the Timeline you imported, or you’re exporting a project 
that wasn’t AAF to begin with: Then you need to right-click the Timeline you want to export 
in the Media Pool and choose Timelines > Export > Generate New AAF. This option creates a 
brand new AAF file, but audio and effects that are not supported in DaVinci Resolve in an AAF 
import are discarded. 

Exporting an EDL
DaVinci Resolve is also capable of exporting EDLs that can be reimported into other applications. 
For more information about EDL workflows, see Chapter 24, “Ingesting From Tape.” see Chapter 56, 
“Conforming and Relinking Clips.” and Chapter 60, “Conforming EDL Files.”

To export an EDL:

1 Open the Edit page and select the Timeline you want to export an EDL from in the Media Pool.

2 Exported EDLs only have a single video track. For timelines with multiple tracks, only the events on 
the video track with the destination control assigned to it will be exported (the destination control 
is the first control at the left in the track header). If you want to export a track other than Video 1, 
you can assign the destination control to the specific track you need to export.

3 Right-click the Timeline in the Media Pool, and choose Timelines > Export > AAF/XML/EDL from 
the contextual menu.

4 When the Export Timeline dialog appears, type a name, choose a location for the exported EDL, 
and choose EDL Files from the drop-down menu at the bottom, then click Save. An EDL is exported.

Exporting a Missing Clips EDL
This command lets you export a quick report listing all clips that are offline in the currently selected 
track of the Timeline in the Edit page. This report is in EDL format, with one event for each clip that’s 
offline, which describes the reel number and source timecode of the missing media, as well as the 
record timecode of the missing media’s position on the Timeline.

4042Deliver | Chapter 190 Exporting Timelines to Other Applications



Here’s an example of an exported Missing Clips EDL:

TITLE: ( no title )

1 A001_C002_0820GA_001 V C 10:28:27:03 10:28:28:00 01:00:00:00 01:00:00:21

2 A004_C012_0820MC_001 V C 14:07:31:21 14:07:35:13 01:00:12:13 01:00:16:05

3 A017_C001_0820CV_001 V C 21:16:14:22 21:16:15:00 01:00:16:05 01:00:16:07

Once you’ve exported this information, you can hand it off to whomever can help you track down the 
missing media.

To export a Missing Clips EDL:

1 Open the Edit page and open the Timeline you want to export a Missing Clips EDL for in the 
Timeline browser.

2 For timelines with multiple tracks, only the events on the video track with the destination control 
assigned to it will be examined for missing clips. If you want to examine a track other than Video 1, 
you can assign the destination control to the specific track you need to examine for missing clips.

3 Right-click the Timeline in the Media Pool, and choose Timelines > Export > Missing Clips EDL from 
the contextual menu.

4 When the Save Missing Clips EDL dialog appears, type a name and choose a location for the 
exported EDL, then click Save.

Exporting Timeline Markers to EDL
If you keep notes about a project within the notes field of Timeline markers, found in the Timeline 
ruler, then it’s possible to export those notes as an EDL.

To export timeline markers as an EDL: 

1 Right-click that timeline in the Media Pool, and choose Timelines > Export > Timeline 
Markers to EDL. 

2 Choose a location and export format from the Export Edit Index dialog, and click Save. Each 
Timeline marker is listed in the resulting EDL, with any notes included along with a duration, 
where applicable.
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Exporting to CDL
DaVinci Resolve can export and import basic grading data to and from other applications via a Color 
Decision List (CDL). CDLs are an industry-standard file format originally developed by the American 
Society of Cinematographers’ technology committee. DaVinci Resolve supports the 1.2 CDL standard 
that defines the slope, offset, and power for each of the red, green, and blue channels, as well as the 
overall saturation of each clip in a program. 

CDL files are formatted similarly to EDLs, with SOP (Slope/Offset/Power), and SAT (Saturation) values 
embedded as metadata in much the same way as comments are in a more typical EDL. 

Here’s an example of a single CDL event:

020 001 V C 03:02:49:13 03:02:53:00 01:01:28:11 01:01:31:22

* ASC_SOP (1.109563 1.717648 0.866061)(-0.238880 -0.390357 0.353743) 
(0.672948 1.384022 0.889876)

*ASC_SAT 1.000000

Because the CDL definition of a grade is so narrow, projects you’re planning to export to other 
applications via a CDL must be constrained to only those operations the CDL mathematically defines. 
Here are some things to keep in mind:

 — Only primary corrections in the first node of each clip are exported.

 — Restrict yourself to using the Lift/Gamma/Gain, Offset, and Saturation controls.

 — Keyframes are never exported. If keyframes are present in a grade, only the parameter values at 
the first frame of the clip are used. 

 — The track grade and group grades are completely ignored.

 — If there is an HSL Qualifier or a Power Window in the first node, it is ignored and the corrections in 
that node are exported as if it were a primary correction.

 — Do not make Y’ only adjustments; they’re not compatible with CDLs. To ensure that your exported 
CDL is accurate, set the Lum Mix parameter in the Primary Controls palette for each grade to 0. 
For workflows involving frequent CDL export, you can turn on the “Luminance Mixer defaults 
to zero” option in the Color  section of the General Options panel of the Project Settings to 
guarantee this parameter is always set to 0.

If your timeline conforms to all of these restrictions, then you’re ready to export a CDL.

To export a CDL:

1 Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose 
Timelines > Export > CDL from the contextual menu.

2 Enter a name for the CDL, choose a location to save it to, and click OK.

For more information on importing a CDL to add grades to your project, see Chapter 146, “Copying and 
Importing Grades Using ColorTrace.”
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Exporting the Edit Index 
as a CSV or TXT File
You can export the current contents of the Edit Index, in the Edit page, as a self-contained file to use 
for reference in a variety of ways. 

To export the Edit Index:

1 Open the Edit Index, and choose one of the Edit Index filters from the Edit Index option menu, 
if necessary. For example, you could filter the edit index by Offline Clips Only if you wanted to 
export a list of all offline clips in the current timeline.

2 Right-click that timeline in the Media Pool, and choose Timelines > Export > Edit Index, then 
choose a location and export format from the Export Edit Index dialog, and click Save.

Exporting to ALE
DaVinci Resolve is also capable of exporting ALE (Avid Log Exchange) files. ALE is a tab-delimited, 
ASCII text-based clip logging list format that enables the exchange of clip metadata that can’t be 
embedded inside MXF files. ALE files are designed to let you export a log of all clips that are used in a 
particular timeline with all of the metadata that’s associated with those clips in DaVinci Resolve, so this 
metadata can be imported into and associated with clips inside Media Composer or Symphony.

ALE files are divided into three sections, labeled Heading, Column, and Data:

 — The Heading provides information about the clips being logged, including the picture and audio 
format, and the frame rate. 

 — The Column line defines each of the columns of metadata being exported in the list. There’s an 
automatic minimum of metadata columns that are automatically included, regardless of whether 
they’re populated or not. However, additional metadata columns are automatically added to 
this list by DaVinci Resolve when any corresponding metadata field in the Metadata Editor is 
populated. For example, if you enter information into the Camera, Keyword, and Shot fields of 
the Metadata Editor, then those columns will be added to the exported ALE. There are no user 
settings that control this.

 — The Data section contains multiple lines, one for each event being referenced in the list, that 
contain all the data corresponding to that clip. 

If you’re exporting stereoscopic clips from stereoscopic timelines, the following additional columns of 
metadata are automatically included in the two ALE files that are generated: 

 — Pan (relative to timeline resolution)

 — Tilt (relative to timeline resolution)

 — Zoom

 — Rotate

 — Convergence (relative to timeline resolution)

 — HFlip (0 or 1)

 — VFlip (0 or 1)
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If you’re exporting ALE files from projects using ARRIRAW clips, the following additional columns of 
metadata can be included: 

 — Temperature

 — Tint

To export an ALE file:

1 Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose 
Timelines > Export > ALE from the contextual menu.

2 Enter a name for the ALE file, choose a location to save it to, and click OK.

The ALE file is saved, and a dialog appears reminding you of the file path to which it was saved 
(click OK to dismiss it).

Here’s an example of a short ALE export:

Heading

FIELD_DELIM TABS

VIDEO_FORMAT 1080

AUDIO_FORMAT 48khz

FPS 23.976

Column

Name, Tracks, Start, End, Take, Tape, UNC, FPS, Reel, Scene, Shoot, date, 
Manufacturer, Source Resolution, Source, Bit Depth, DESCRIPT, Comments, 
Audio SR, Audio Bit Depth, Auxiliary TC1, KN Start, Source File Path, 
Display Name

Data

A001_C002_V01.CBF6A4FD139AD.mxf, V, 10:28:27:03, 10:28:28:00,  
A001_C002_V01.CBF6A4FD139AD 
/Volumes/Disk_1/Avid MediaFiles/MXF/1/A001_C002_V01.CBF6A4FD139AD.mxf 
23.98, DaVinci Resolve, 1920x1080, 10 
/Volumes/Disk_1/Avid MediaFiles/MXF/1/A001_C002_V01.CBF6A4FD139AD.mxf 
A001_C002_V01.CBF6A4FD139AD

A016_C008_V01.CBF6A4FD13ABD.mxf,V, 23:35:56:03, 23:36:00:11,  
A016_C008_V01.CBF6A4FD13ABD 
/Volumes/Disk_1/Avid MediaFiles/MXF/1/A016_C008_V01.CBF6A4FD13ABD.mxf 
23.98, DaVinci Resolve, 1920x1080, 10 
/Volumes/Disk_1/Avid MediaFiles/MXF/1/A016_C008_V01.CBF6A4FD13ABD.mxf 
A016_C008_V01.CBF6A4FD13ABD

A004_C012_V01.CBF6A4FD1438E.mxf, V, 14:07:31:21, 14:07:35:15,  
A004_C012_V01.CBF6A4FD1438E 
/Volumes/Disk_1/Avid MediaFiles/MXF/1/A004_C012_V01.CBF6A4FD1438E.mxf 
23.98, DaVinci Resolve, 1920x1080, 10 
/Volumes/Disk_1/Avid MediaFiles/MXF/1/A004_C012_V01.CBF6A4FD1438E.mxf

NOTE: The commas shown above are not normally in the ALE but shown here for 
field clarity
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To export an ALE file:

1 Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose 
Timelines > Export > ALE from the contextual menu.

2 Enter a name for the ALE, choose a location to save it to, and click OK.

Exporting to ALE with CDL
Avid Media Composer and Symphony also support the import of ALE files with additional CDL 
metadata columns with which to associate SOP (Slope/Offset/Power) and SAT (Saturation) adjustment 
metadata to each clip that’s logged in the ALE. 

When you import an ALE with CDL file into Media Composer, the SOP and SAT data populate metadata 
columns for preservation and export in various Avid workflows. Here’s an example of the Heading, 
Column, and Data sections of a sample ALE with CDL, with one line of clip and CDL data.

To export an ALE with CDL file:

1 Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose 
Timelines > Export > ALE and CDL from the contextual menu.

2 Enter a name for the ALE file, choose a location to save it to, and click OK.

The ALE file is saved, and a dialog appears reminding you of the file path to which it was saved 
(click OK to dismiss it).

Here’s an example of a short ALE with CDL export:

Heading

FIELD_DELIM TABS

VIDEO_FORMAT 1080

AUDIO_FORMAT –

FPS 23.976

Column

Name, Tracks, Start, End, Take, Tape, UNC, FPS, Reel, Scene, Shoot date, 
Manufacturer, Source Resolution, Source Bit Depth, DESCRIPT, Comments, 
Audio SR, Audio Bit Depth, Auxiliary TC1, KN Start, Source File Path, 
Display Name KeyKode, ASC_SOP, ASC_SAT, RESOLVE_SIZING

Data

A001_C002_V01.CBF6A4FD139AD.mxf, V, 10:28:27:03, 10:28:28:00,  
A001_C002_V01.CBF6A4FD139AD 
/Volumes/Disk_1/Avid MediaFiles/MXF/1/A001_C002_V01.CBF6A4FD139AD.mxf 
23.98, DaVinci Resolve, 1920x1080, 10 
/Volumes/Disk_1/Avid MediaFiles/MXF/1/A001_C002_V01.CBF6A4FD139AD.mxf 
A001_C002_V01.CBF6A4FD139AD 
(1.0260 1.0260 1.0260)(-0.0260 -0.0260 -0.0260)(0.8237 0.8237 0.8237) 0.8640 
(0.0000 0.0000 1.0000 0.0000 0.0000 0 0)

NOTE: The commas shown above are not normally in the ALE but shown here for field clarity
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Exporting Timeline Markers to EDL
This command lets you export a quick report listing the text of all markers that have been added to 
the Timeline as notes in an EDL. Clip markers are ignored. This report is in EDL format, with one event 
for each Timeline marker, with a placeholder reel number (001 by default), and source and record 
timecodes that correspond to each marker’s position in the Timeline (with a duration of one frame). An 
EDL note for each event lists the Marker note, if there is one. There is no note available for the color of 
the markers

Here’s an example of an exported Timeline Marker EDL:

TITLE: ( no title )

001  001 V C 01:00:09:09 01:00:09:10 01:00:09:09 01:00:09:10  

Replace with another car door sound effect

002  001 V C 01:00:20:12 01:00:20:13 01:00:20:12 01:00:20:13  

Trim this clip shorter

003  001 V C 01:00:30:12 01:00:30:13 01:00:30:12 01:00:30:13  

Find another stock footage clip of the bridge

004  001 V C 01:00:30:13 01:00:30:14 01:00:30:13 01:00:30:14  

Trim this montage three seconds shorter

Exporting and Importing 
Media Pool Metadata
DaVinci Resolve makes it possible to export metadata from the Media Pool of one project for import 
into the clips of another project, for instances where you need to move metadata around. This process 
exports all metadata from the Media Pool as a .csv file.

For example, a DIT might have entered a lot of metadata to the DaVinci Resolve project used for 
generating dailies, but then an impatient editor might have created a separate project to begin editing 
those dailies. Instead of requiring the editor to enter each clip’s metadata all over again, you can 
export the metadata from the DIT’s project and import it into the editor’s new project, automatically 
matching the relevant metadata to each corresponding clip. 

To export Media Pool metadata:

1 Open a project containing Media Pool metadata you want to export.

2 Optionally, select which clips in the Media Pool you want to export metadata for.

3 Choose File > Export Metadata From > Media Pool to export metadata from every clip in the 
Media Pool, or choose File > Export Metadata From > Selected Clips to only export metadata from 
clips you selected in step 2.

4 When the Export Metadata dialog appears, enter a name and choose a location for the file to be 
written, then click Save. All metadata is exported into a .csv file that can be viewed and/or edited 
in any spreadsheet application.
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To import Media Pool metadata:

1 Open a project containing clips you want to populate with imported metadata.

2 Optionally, select which clips in the Media Pool you want to import metadata to.

3 Choose File > Import Metadata To > Media Pool to import metadata to potentially every clip in the 
Media Pool, or choose File > Import Metadata To > Selected Clips to only import metadata to clips 
you selected in step 2.

4 When the Import Metadata dialog appears, choose a metadata .csv file to import, and click Open.

5 When the Metadata Import dialog appears, choose the Import Options you want to use to 
match the .csv file’s metadata to the correct clips in the currently open project. By default, 
DaVinci Resolve tries to use “Match using filename” and “Match using clip start and end Timecode” 
to match each line of metadata in the .csv file with a clip in the Media Pool, but there are other 
options you can use such as ignoring file extensions, using Reel Name, and using source file paths.

6 Next, choose which Merge Option you want to use in the Metadata Import dialog.  
There are three options:

 — Only update metadata items with entries in the source file: The default setting. Only 
updates a clip’s metadata if there’s a valid entry in the imported .csv file. Other clip metadata 
fields are left as they were before the import.

 — Update all metadata fields available in the source file:  For each clip that corresponds to 
a line of metadata in the imported .csv file, every single metadata field referenced by the .csv 
file is overwritten, regardless of whether or not there’s a valid entry for that field.

 — Update all metadata fields available in the source file and clear others:  For each clip 
that corresponds to a line of metadata in the imported .csv file, every single metadata field 
referenced by the .csv file is overwritten, regardless of whether or not there’s a valid entry for 
that field. Furthermore, metadata fields that aren’t referenced by the imported .csv file are 
cleared of whatever metadata was there before.

The Metadata Import dialog that lets you choose options for 
how to match and merge imported metadata

7 The Metadata Import dialog that lets you choose options for how to match and merge 
imported metadata

8 When you’re finished choosing options, click Ok and all available metadata from the source .csv 
file will be imported.
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